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Preface Working with today’s digital cameras can be joy because of its interactive nature. But there is also a lot to learn to master this new medium. Most of today’s modern digital Single-lens Reflex cameras (DSLR) and some high end digicams support a RAW format. Photographing using the RAW image format will allow you to obtain the best quality from your camera. First, you need to master the RAW file workflow. The RAW image format is the data as it comes directly off the CCD or CMOS sensor, with only rudimentary in-camera processing performed. Our book provides you with complete introductions to master the digital photography workflow. By following our step-by-step instructions, you will be able to take full advantage of the quality that you camera can provide. Be aware that we provide a workflow that works for us. Once you have learned our way of doing things, you then will improve and find your own personal workflow. Chapters 2 covers the basics of the digital photography editing process to help you understand and follow our workflow. ƒ



Color Management, Photoshop® CS basics, tools and techniques



Chapter 3 covers what you need to know to master the raw file conversion and Camera Raw 2.0, Capture One DSLR and Nikon Capture. Chapters 4 teach the use of layers in Photoshop. All our workflow will be from that moment on only layer based. Chapter 5 defines the workflow in all its steps Chapter 6 show some more advanced techniques for you to use. Chapter 7 is a catalog of additional imaging tools that can enrich or ease your workflow Chapter 8 briefly gets into some printing and web publishing options x



Chapter 9 introduces the exciting world of B&W photography using digital color photos. Chapter 10 outlines what you need to do for backup and archiving We do not want to push the tools we present here. Either the tools we present do a better job than the Photoshop equivalent or they are easier to use. Most of the software comes with a free demo version: Try before you buy. The art of digital photography is rich in potential, and the technology for producing quality images is still evolving. We are pleased to offer this book as a tool for producing images in this electronic age. We believe that this tutorial material will significantly enhance your ability to explore this exciting technology and help you enjoy the process of discovering the world of digital photography. Bettina and Uwe Steinmueller January 2004
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1 INTRODUCTION
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1.1 INTRODUCTION TO THE DIGITAL PHOTOGRAPHY WORKFLOW What is the digital photography workflow? All you want is to take a picture and get to a great output. But the process should be: •



Fast



•



At reasonable cost



•



Getting optimal quality all the time



Digital workflow includes everything from the moment you take a picture until you print and archive it. Unfortunately there is no silver bullet that guarantees your success in all of these areas. This book will not even try to sell you this kind of illusion. But what we can do is present a proven workflow that will enable you to: •



Improve your output quality



•



Save you time by avoiding costly own exploration



Our book tries to be as simple as possible but not simpler. It is not the goal to be the best master in Photoshop and other tools. We want you to teach how to use all needed imaging tools in a way that you can create the images you want without too much trial and error.



© 2002-4 Bettina and Uwe Steinmueller
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1.2 HOW TO USE THIS BOOK / HOW THIS BOOK IS ORGANIZED Chapters 2 covers the basics of the digital photography editing process to help you understand and follow our workflow. ƒ



Color Management, Photoshop® CS basics, tools and techniques



Chapter 3 covers what you need to know to master the raw file conversion and Camera Raw 2.0, Capture One DSLR and Nikon Capture. Chapters 4 teach the use of layers in Photoshop. All our workflow will be from that moment on only layer based. Chapter 5 defines the workflow in all its steps Chapter 6 shows some more advanced techniques for you to use. Chapter 7 is a catalog of additional imaging tools that can enrich or ease your workflow Chapter 8 briefly gets into some printing and web publishing options Chapter 9 introduces the exciting world of B&W photography using digital color photos. Chapter 10 outlines what you need to do for backup and archiving Once you reached chapter 5 (sorry it takes that long) you should be able to use the workflow and create your own variations. In these chapters you should only skip content if you know it already. We try to build the workflow from ground up. We have included some of our photographic artwork to remind you that it is all about good pictures and not just technique. We prefer a great vision that may be not perfectly executed, over a technically perfect boring picture. We hope you understand what we mean by this. In the end your eyes are the most important tools to succeed in photography. Keep your vision fresh!



© 2002-4 Bettina and Uwe Steinmueller
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1.3 USING PCS AND MACS We work on PCs most of the time . Fortunately ,Photoshop CS is pretty much the same for PCs and Macs (besides some different keystrokes). This makes all the Photoshop content is valid for both platform. There are a few tools that we use that are only available for the PC. In most cases you can find an equivalent tool for the Mac platform. Why are we using a PC? Simply because we have used PCs for many years. If we had used Macs before, this would be our platform today.



© 2002-4 Bettina and Uwe Steinmueller
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1.4 COMPUTER CONFIGURATION



Image processing is quite demanding on your computer hardware. Here are some guidelines (valid for Macs and PCs):



•



1GB of memory is a good start (more does not hurt)



•



Don’t settle for low quality monitors.



•



1280x1024 and more are good resolutions (we use 1600x1200)



•



Having USB 2.0 and Firewire ports is a plus



•



Dual Processor is a plus and will be utilized by Photoshop



•



Disks o 1x 80GB or more for your OS o 1x 80GB or more for working files o 2x 80GB or more foe archiving (external USB 2.0 or Firewire drives



•



External CF card reader with USB 2.0 or Firewire connection (USB 1.0 is much slower)



•



DVD reader/writer (external Firewire is fine)



•



Device for monitor profiling (see later chapter)



© 2002-4 Bettina and Uwe Steinmueller
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1.5 WHAT ARE RAW FILES In many aspects using a film camera and a digital camera is the same. This section concentrates on the things that are different and have to be known to begin the digital workflow with the best possible photographic material. As always, the best framing and optimal exposure lead to better images. Otherwise, garbage in means garbage out. This does not mean you can not get great pictures from less than optimal shots. But be prepared. This means much more work in the digital darkroom The most common image format used these days with digital cameras is the JPEG format (Joint Photographic Experts Group). The obvious limitation of JPEG is that it is most often used for its excellent, but lossy compression format (there is also lossless JPEG that is rarely used in cameras). Even at low compression rates, the image degrades slightly. A more important point is the fact that the images undergo heavy color/exposure/noise/sharpening processing in the camera. This reduces the ability to make further postprocessing. The JPEG compression works best for images in no need of further substantial post-processing (which is rare if you get demanding) or under circumstances where such post-processing is prohibited. Many photographers try to get the best possible quality out of their cameras using TIFF, or if supported by the camera, a vendor specific raw file format. As you will see, the raw file formats allow the most post-processing flexibility. If you decide to stay with using only JPG, it does not mean that you cannot use our workflow. In this case you used the raw converter that is built into your camera. All the steps that apply after the raw conversion are also valid for JPG images. But even if you don’t use raw, it would be good for you to better understand what raw is all about. 1.5.1 THE RAW FILE ADVANTAGE? To better understand what these magic raw file formats are, you need to understand how most of today’s digital cameras work. All our new digital cameras capture color photos, right? Yes, you finally get your color images but most of the modern digital cameras have sensors that can only record © 2002-4 Bettina and Uwe Steinmueller
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gray scale values (the Foveon X3 sensor, digital scanning backs and multishot digital backs are the exceptions). Assume you want to photograph a box of Crayola crayons:



Full colored sample target A gray scale sensor would see the picture like in the figure below and you would never get any color photos at all.



Gray scale picture seen by the sensor



© 2002-4 Bettina and Uwe Steinmueller
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How can you use a gray scale sensor to capture color photos? Engineers at Kodak came up with the following method , called Bayer Pattern. Dr. Bayer is a Kodak scientist who invented this novel Color Filter Array configuration back in the eighties.Hence the name Bayer pattern. There are also other pattern variations used): r-g-r-g-r-g g-b-g-b-g-b r-g-r-g-r-g g-b-g-b-g-b First, it is interesting to note that 50% are green and only 25% for each red and blue. The reason for this is that the human eye can differentiate far more green shades than red and blue. Not really a surprise if you look at nature. The Green also covers the most important and widest part of the visible spectrum Now our sensor captures gray values filtered by these color filters.



Color mosaic seen through the color filters However, you want to have a photo with full color information for every pixel. Here a software trick comes into play called Bayer Pattern demosaicing or color interpolation. What actually happens is that the missing RGB information is estimated from the neighboring pixels.



© 2002-4 Bettina and Uwe Steinmueller
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A good demosaicing algorithm (the method of turning the RAW data into a full color image) is actually quite complicated and there exist many proprietary solutions in the market. The problem is to resolve detail and still be correct with the colors. To illustrate some of the challenges think of capturing a small black & white checker pattern that is small enough to just overlay the sensor cells:



Demosaicing Errors As the neighboring green filtered photo site does not add new information, the algorithm would not know whether it would be some kind of “red” (if the white hits a red filter) or “blue” (if the white hits the blue filter). In contrast, for example, a Foveon sensor would capture white and black correct as all three color channels are captured at the same photo site. The resolution captured by the Bayer sensors would drop if the subject only consists of red and blue shades, since the green channel could not add any information. For monochromatic Red/Blue (very narrow wavelengths) the green sites get absolutely no information, but such colors are rare in real life. In reality, there is information in both green and to a much less extent even blue, if the sensor samples very bright and saturated red colors. The problem © 2002-4 Bettina and Uwe Steinmueller
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in our example above is the fact that estimating the color correctly requires a certain amount of spatial information. If only a single photo site samples the red “information” there will be no way to reconstruct the correct color for that particular photo site. The above next crops are from real samples that were made in a studio to show the practical effect. Of course, these test photos show an extreme situation here. In reality the failure is less dramatic but can still be visible by our eyes and definitely should not be ignored.



Fooling a Bayer sensor Some of these challenges result in image artifacts like moirés and color Aliasing (shown as unrelated green, red, blue pixels or resulting in discoloration). Then most cameras fight the Aliasing problem by putting an AA (Anti-Aliasing) filter in front of the sensor. This filter actually blurs the image and distributes color information to the neighboring photo sites. As you know blurring and photography don’t really match up. To find the right balance between blurring and Aliasing is a camera design challenge. In our experience the Canon 1Ds does a very good job here. Finally the image needs stronger sharpening to get back most of the original sharpness. To some extent AA filtering degrades the effective resolution of the sensor.
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This sounds like a complicated mission. Indeed it is, but works in the end surprisingly well. Every technology has to struggle with its inherent limitations. In many aspects digital can beat film today as film has to fight its own limitations. Now we can say what the raw data are for any given digital camera. The raw data are the data for all the gray values captured on the chip. To produce a final image these raw data have to be processed (including the demosaicing) by a raw converter. To produce JPEG images the camera has to have a full raw converter embedded in the camera’s firmware. What are the limitations of using the camera produced JPEGs: •



JPEG artifacts due to lossy compression



•



Although most sensors capture 12 bit color (gray scale) information only 8 bit are used in the final file



•



The in camera raw converter can only use limited computing resources but good raw conversion can be very complex and computing intensive. As software technology evolves its much more flexible to have the conversion done on the host computer instead of the no-upgradeable ASIC commonly used today.



•



The in-camera set or estimated white balance (WB) gets applied in the camera to the photo. The same is true also for color processing, tonal corrections, in camera sharpening. This limits the post-processing capabilities, as an already corrected image needs to be corrected again. The more processing is done on a photo (especially 8bit) the more it can degrade.



Now we can explain what the different raw files formats are. They store only the raw data (plus some additional meta data to describe the properties of the RAW data in EXIF section of the file –The EXIF sections holds information like camera type, lens used, shutter speed, f-stop and much more). Now all the processing done in the camera can be performed on a more powerful computing platform •



No JPEG compression



•



Full use of the 12bit color information
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•



Use of very sophisticated raw file converters (like Adobe Camera Raw or Phase One’s Capture One DSLR)



•



White balance, color processing, tonal/exposure correction, sharpening and noise processing can be processed later on the computer



•



The raw files also act more like a digital version to the undeveloped film negative. Over time there are improved raw file converters that let you get better and better results from the same data.



In-camera JPEG is like shooting a Polaroid (where you just shoot and get your image processed immediately) and the RAW is like the film that can be developed and enhanced in the dark room. Raw converters like Phase One’s Capture One DSLR act like your magic formula of film developer. What is the advantage of 12 bit data? The main advantage exists if you need to make some major corrections to the white balance, exposure and color corrections. During the processing of an image, you lose bits of image data merely due to data clipping (accumulating over multiple steps). The more bits you have in the beginning the more data you have with your final corrected image. What about using TIFF files in the camera? Actually TIFF files only solve the lossy compression issue but are still converted to 8 bit inside the camera. Most of the time TIFF files are larger than raw files (remember raw files only hold one 12 bit gray value per pixel) and don’t have the other benefits of raw. I would go as far as saying that an 8 bit in camera processed TIFF file is only slightly better than a high quality / high resolution JPEG. Digital Camera Artifacts The current sensors do not record the full RGB color and only interpolate the color but, with a price. 1.5.2 COLOR ALIASING / MOIRÉS What happens when a fine red line crosses a green photo-site and not any neighboring red photo-sites? There would be no indication of this red line in the RAW data. To combat this effect most cameras have fixed mounted AA © 2002-4 Bettina and Uwe Steinmueller
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filters. These AA filters blur the image so that the neighboring photo-sites also acquire some red line information. While the AA filter fixes one problem, it introduces a different problem, a loss in sharpness. This means that you need to do some strong sharpening later during the RAW workflow. Keep in mind, lost detail can not be recaptured later by whatever fancy sharpening methods. It does, hoever, do quite a good job and digital cameras work much better than this sounds.



1.6 WHAT ABOUT ONLY USING JPEG AND NOT RAW? There are a couple of reasons to use JPEG as the main image format: •



Your camera has no, or poor, raw support



•



You want to get your images ready processed from the camera



•



Raw converters seem too much of a hassle for you



•



Raw files use too much space on your memory cards



Even though we list the main advantages of using raw files, it does not mean you cannot get excellent results from your JPEG images. Actually you are also using a raw processor, but this one is built right into your camera. This means nearly all workflow steps will be the same and no reason not to learn about our workflow. As it is harder to correct white balance and exposure with JPEGs you should pay even more attention to: •



Get best possible WB from the camera. Some digital cameras deliver quite good auto white balance.



•



Nail the exposure as perfect as possible and also avoid any kind of overexposure. Your histogram is your friend. Some newer digicams like the Sony F828 show even a live histogram in the viewfinder that helps for perfect exposures.



The settings in your camera can also directly affect your images. Try to use the following setting: © 2002-4 Bettina and Uwe Steinmueller
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•



Sharpening in camera to low or off



•



Contrast in camera to low or normal



•



Colors to natural and low saturation (you can improve saturation later)



•



Use Adobe RGB 1998 color space if possible



•



Set saturation to low or normal



•



Use highest resolution JPEGs if possible with the lowest compression available



Once you start processing your images convert the results to TIFF to avoid further quality losses due to JPEG compression. In conclusion you should use raw files whenever you feel comfortable using them. But that does not mean that you cannot get great results starting with well exposed JPEGs from your camera and following our workflow.
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1.7 CAPTURING PHOTOS IN THE FIELD Follow the setup instructions in your camera manual to shoot raw files or use JPEG at highest resolution and lowest compression. Raw files use up more space than JPGs, so have enough CF cards or Microdrives available. We use only 4GB, 1GB or 340MB Microdrives, as they are the cheapest medium per MB at this time. They may be a bit more risky in terms of data loss due to mechanical failure or drop and require careful handling. 1.7.1 OPTIMIZE EXPOSURE USING YOUR CAMERA’S HISTOGRAM The right exposure is key to your success with the raw file workflow. Never overexpose your photos. In this case, the highlights may be lost and recovery is not possible. But here is help which only the digital camera can provide: The cameras provide a way to view the result of the last photograph taken and show a histogram of the grayscale values from 0 (black) to 255(white). Here are three histograms examples (created in Photoshop) that show different characteristics.



Histogram 1: Severe overexposure



Histogram indicating strong overexposure The highlight (right side of the histogram) has just been lost. This would be a candidate for deletion in all but a few very rare cases. Some might recommend to "burn" the photo in Photoshop. Still that is faking details in the highlights that are not there.
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Histogram 2: Minor overexposure



Histogram indicating potential overexposure Here is only a small spike in the highlights and it very much depends on the photo whether this might be a problem or not. If the spike represents a real pure white or an unimportant spectacular highlight then this photo may be OK. Otherwise, you are in trouble.



Histogram 3: Good exposure



Histogram indicates good exposure Here the highlights are OK. You lost a bit of the dynamic range in the highlight area but Photoshop can correct for this. You should endeavor to get histograms like this. In principle it is best to get as close as possible to the right. Read the next section and you will understand why it is safer to slightly underexpose than risk any highlight clipping. Some histograms are also hard to read outdoors in bright daylight. 1.7.2 COLOR CHANNEL CLIPPING Some clipping can even happen in the one or two color channels. In this difficult situation, it would be very helpful if you also had histograms for the three-color channels (like very few cameras have). Here is an example from the Canon 10D that demonstrates typical problem with saturated colors. Blue, orange and yellow flowers are good candidates and it is safer not to use up the full exposure headroom to the right. © 2002-4 Bettina and Uwe Steinmueller
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Candidate for blue channel clipping The histogram in Camera Raw 2.0 shows clearly the challenge in the blue channel.



Camera Raw 2.0 histogram Also the Capture One’s channel histograms indicate clipped channels.



Capture One DSL histogram This overexposure in the blue channel was not shown by the camera histogram as it uses an average of all the three channels (most often they use a so called luminance histogram). © 2002-4 Bettina and Uwe Steinmueller
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Tip: Do not blow out the highlights. Of course, the histogram only helps if you can repeat the shot. Fortunately, in nature photography, this is often the case except for photographing birds and other wildlife. Unfortunately, even the sophisticated exposure measurement of today's cameras is often not good enough to get a perfect exposure every time. Many photographers are very in good exposure metering but watching for the histogram gives much even more control. If you have an overexposure, you can dial in an EV (exposure) compensation and repeat the shot. You should continuously watch the histogram. Some cameras allow the display of the histogram automatically after very shot (highly recommended). When working from a tripod use only manual exposure. This is easier than using EV correction to correct the exposure. The right values do not change that often. If the light is the same, the camera metering might just have changed because of the scene. 1.7.3 CORRECT WHITE BALANCE (WB) FOR OPTIMAL COLOR QUALITY The key to correct colors is getting the WB right. White balance depends on the light source or sources that illuminate the photographed scene. When using film the choice of film type or the filters used to compensate for different lighting (indoor, sun, cloudy, shade, flash, etc…) influences the white balance. If you only use raw file formats, the WB can be corrected later. For fine art photography, the true color isn’t what really counts (would someone use Velvia™ for that?) Most of you are more interested in the subjective correct WB. Digital SLRs allows you to measure the right WB (custom WB) at the time you photograph. This might be optimal, but is not always easy in the field (nature). Therefore, set the WB to “auto” for the all cameras and adjust the WB later in the raw converter. A very good practice is to photograph a gray card (or even better, a Macbeth ColorChecker) in the same light as the following photos and use this photo later for the right WB correction.
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Correcting WB (and color in general) is very tricky, highly subjective and needs a lot of experience. With practice, you will get better. In addition, one thing has to be observed: The judging of colors is very much a function of mood. Sometimes colder colors (more blue) are found, and then you might want more warmth (more yellow). These experiments add up to a lot of time optimizing your images. If you sometimes feel lost don't worry, you are not alone! 1.7.4 UNDERSTAND OBJECTIVE AND SUBJECTIVE WHITE BALANCE There is a big difference between pleasing and correct colors. Only in a few photographic disciplines do you really care about the right color. This is the case for photographing fabrics and maybe catalog shots. Otherwise you mostly aim for pleasing colors. The most discussions occur over what makes a good skin tone. Here there even exist a lot of cultural differences. Start with a white balance you like, optimize the contrast and only change colors selectively if there are major issues. Some might need to correct skin tones, while others the colors of boring blue skies. 1.7.5 ADJUST YOUR CAMERA’S SENSITIVITY: SELECTING THE RIGHT ISO Today’s digital cameras allow you to change the ISO value on the fly by just dialing a new value. This is a big plus of digital because you can change ISO speed on a picture by picture basis. A low ISO normally means lower noise (better image quality) and a high ISO means higher noise (lower image quality). Noise can show up in many different ways. If a camera shows the noise like grains of “salt and pepper” then this is very positive, as we all are accustomed to this grain from our film based experience. Note: Stay at low ISO whenever possible and use a tripod! If you need to use higher ISO then try to improve your photos by using top class noise removal tools (see noise removal).
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We show the workflow steps already at this early stage so that you better understand the context of the following chapters. 1.8.1 PRINCIPLE WORKFLOW STEPS (THE “WHAT”) The following diagram shows all the aspects you need to be aware of if you want great photos. Don’t worry you will learn all this step by step. The most fulfilling aspect of digital photography is that you can improve all the time and still produce good results while learning more. This diagram shows what has to be considered and done right: Camera



Capturing Photos in the Field Transfer to Computer Renaming Backup



Negative



Select Images with „Digital Light Box“ RAW Conversion Noise & Dust Removal Initial Sharpening Get global Color right Contrast, Brightness, Saturation Rotating, Perspective, Lens corrections Local Color, Sharpness, Contrast Backup



Print



Archive



Print in PS



Archiving Backup
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1.8.2 ESSENTIAL DIGITAL IMAGE PROCESSING KNOWLEDGE (THE “HOW”) When you know what has to be done then the next step is to learn how it can be mastered. There is rarely just a single good solution. Our workflow teaches a few of them that helped us. Camera



Know your Histogram Understand Raw files Understand Image Organisation



Negative



Basic Color Management Understanding RAW Converter Basics Dust Removal Sharpening Techniques Color Correction Methods Exposure, Contrast, Brightness, Saturation Rotating, Perspective Optimize (local) Color, Sharpness, Contrast Image Formats



Print



Printer Profiles Rendering Intent



Archive
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1.8.3 ADVANCED DIGITAL IMAGE PROCESSING KNOWLEDGE There are some advanced features that you might not learn in the first round. Don’t worry, have a look at it later. Learning is always an iterative process. Master the workflow one step at a time.



Camera



Extending Dynamic Range Creating stitched Images



Negative



16 vs. 8 bit Photoshop Layers Image Color Modes Working with Selections Noise Removal History Painting Lens corrections Using and Creating Actions in Photoshop B&W from Color Images



Print



Know your Papers B&W Printing Using RIPs for Quality Printing



Archive
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We will not cover all the elements of the advanced section in our book.



1.9 CAMERA TO COMPUTER: ENTER THE DIGITAL DARKROOM 1.9.1 MANAGE YOUR IMAGE STORAGE Once you are back from the field with your compact flash cards and/or digital wallets filled, it is time to transfer these files to your computer. Be aware that this requires a lot of disk space. Converting some of these images to 16-bit TIFFs makes even more demands on disk space. Maybe you should start thinking in Gigabytes and soon in Terabytes. We currently have about 1000GB of storage in our network (needs organization and with duplicates sitting somewhere). A good starting point is 80GB as a minimum and adding some external Firewire drives as backup (start with 160GB). 1.9.2 COMPUTER TRANSFER AND ORGANIZING YOUR PHOTOS Most cameras today come with an USB or a Firewire interface. Many use these camera interfaces to transfer the files to the computer. We do not use these camera features, as it does not help a lot once you use multiple cards and/or digital wallets and we also don’t think cameras are the most robust CF card readers. We have a USB 2.0 card reader installed with our main PC (we use PCs but the same is true for Macs) and copy the images from a days shoot to a new directory in our "inbox" folder.
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Inbox folders We use many different cameras and the goal is that every image has a different name (even if we use two cameras of the same type). The following explains the file hierarchy: *



all_2003: all raw files from all cameras for 2003 fit here



* all_dvd_2003_001: this is the first DVD set (or you may also use CDs) for 2003. We always create a new folder if the content exceeds about 4GB to fit on one DVD (or 600MB for one CD) * 20030913_300d_LosGatos: this is a folder from one photo session in Los Gatos (actually better name it “Los_Gatos” as some archival tools can filter out the names. *



The name contains the date yyyymmdd for easier sorting



*



300d for camera used



* Subject (sometime followed by “_01” … “_0x” if we have more than one card used that day. We rename all image files to: 300d_nnnn_mmm where: *



300d stands for camera type



* nnnn is a sequence number (starting at 0000) and then incremented. What is this for? You might have two 300D cameras and still all images
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should have a unique filename. Also after 9999 the camera will restart at 0001. The sequence number will allow again unique file names. If we later work on our files in Photoshop we save the results as a master TIFF file. The file name will keep our original “300d_nnnn_mmm” file name and we append some more descriptive text to it: Example: *



Original: 300d_0001_1256



*



Derived: 300d_0001_1256_Los_Gatos_Bear_Cafe



This way every file is linked by the original file name to the raw file in our archives.



Renaming After copying the files to the disk, we then rename the files to make sure that the filenames will stay unique. We use a free PC utility called "Rnameit" (you can download it from our web site) but there are also many others programs available. The Photoshop CS File Browser and Capture One also allow you to rename your files. We find Rname-it more flexible for our use. We can easily replace a file name prefix for all the digital cameras we use with a name like “1Ds_0000_”.
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Freeware PC renaming tool
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1.10 SECURING YOUR VALUABLE PHOTOS: BACKUP After transferring the images, you should backup these files to a physically different hard disk. Now you should be safe to reformat the CF cards or Microdrives Tip: Backup, Backup, Backup *



Make backup CDs or DVDs



* Use different CD/DVD brands if you make two copies. If one CD from manufacturer A fails there is a great chance that also the other copies will be bad too. *



Store copies in different locations



* Once you have the files on your disk drives, you can safely enter the digital darkroom. Note: In some cases, your Microdrive or CF card might be corrupted. Do not panic, get Photorecue (for more information consult our web site).



1.11 THE DIGITAL NEGATIVE/SLIDE What you now have on your computer is often called “digital negatives”. We recommend that you keep these raw or original JPEG files as they hold all the information that you captured in the field. You may want to revisit these original raw files in case: •



You improved your own digital workflow over time (very likely)



•



Better raw converter software will be available. We have seen many improvements over the last four years and expect more to come.



•



You lost your derived files
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Actually, a raw file is even more like a latent image and the raw converter software acts like your preferred magic developer. The only big difference in digital is that you can do multiple forms of development over time.



1.12 THE DIGITAL LIGHT TABLE A very important phase for every photographer is the inspection of new and old images. Especially when you just uploaded your work to your computer you want to analyze your new images as fast as possible to start working on the keepers. A small thumbnail as older files browsers show is not good enough to find out whether the following criteria are met. As we also want to preview raw files our digital light table needs to be integrated with a complete raw converter. •



Is the composition ok?



•



Is critical sharpness archived?



•



Is the exposure ok? Here we need to see a histogram



•



Quality of colors. This step most often also requests a correction of white balance.



We now have a look at the preview capabilities of the two currently leading third party raw converters: •



Photoshop CS with Camera Raw 2.0



•



Capture One DSLR



The preview process is a critical starting point for any workflow in the digital darkroom. 1.12.1 IMAGE PREVIEWS WITH THE PHOTOSHOP CS FILE BROWSER The Photoshop CS File Browser provides quality previews (1024 pixels wide) and also very large thumbnails (we use 400 pixels wide custom thumbnails). Both the thumbnails and the previews are generated by the Camera Raw 2.0 raw converter and reflect the current setting for each file. © 2002-4 Bettina and Uwe Steinmueller
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CS File Browser with large thumbnails and quality preview Unfortunately the CS File Browser does not support a histogram for the currently selected file. But otherwise the CS File Browser provides a good solution for inspecting new raw files. Camera Raw 2.0 also supports most of the raw file formats by current digital cameras in the market. 1.12.2 IMAGE PREVIEWS WITH THE CAPTURE ONE DSLR (C1) C1 provides an integrated solution of digital light table and raw converter. That is why C1 is mainly designed as a raw only file browser.
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C1 with large thumbnails, quality preview and histogram The tight integration of browser and raw converter in C1 allows instant previews, white balance and exposure corrections. At the time of writing this book Capture One DSLR only supported the digital SLRs from Canon and Nikon (which are the majority of the digital SLR market).
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1.12.3 IMAGE PREVIEWS WITH THUMBSPLUS (PC ONLY)



ThumbsPlus Pro (PC only) ThumbsPlus is not only an excellent adhoc image browser, but can also be used to catalog offline media. We often use ThumbPlus as we like to have multiple folders open at the same time and switch between these views. Here are a few highlights of Thumbsplus as an image browser: •



Multiple folder windows



•



Can easily launch images into Photoshop



•



Adhoc full screen slide shows (missing in the Photoshop file browser)



•



Display of most raw file formats
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Digital Photography Workflow Handbook



CHAPTER



2



2 DIGITAL DARKROOM BASICS



Camera: Canon 1Ds
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2.1 DON’T BE AFRAID OF PHOTOSHOP We know the feeling you get the first time you run Photoshop. To learn it all might take a lifetime. But you don’t need to know it all. Learn as you go! We will try to make your life easier and cover only those features we use and go from simple to advanced features. We cover Photoshop the same way a new user would begin using it. We start simple and grow from there. On the other hand, we assume that you have worked on some tutorials and understand the Photoshop basics: Menus and Tools.



2.2 UNDERSTAND THE DIFFERENT COLOR MODES There are different color models supported in Photoshop. The main four are: •



RGB



•



LAB



•



CMYK



•



Grayscale



See the section about the Color Picker at the end of this chapter. 2.2.1 RGB COLOR MODE
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RGB is the most commonly used color mode today in digital photography. Our workflow will be performed mainly in this mode. RGB is an additive color model. All colors are built from three components; Red, Green and Blue. A triple (0, 0, 0) defines black and (255, 255, 255) is a bright white (should rarely occur in any image). We will later discuss that RGB values do not define absolute colors, but are device dependent instead. 2.2.2 LAB COLOR MODE



LAB Color Model



The CIE-LAB color mode is important for understanding color management. There are also some interesting techniques that use the LAB mode. The interesting aspect of LAB is that it separates color (chroma, A+B) from the detail/brightness (luminance, L) in images. 2.2.3 CMYK COLOR MODE
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CMYK Color Model Although this is an important color model for the printing press it is not used much in digital photography. Even if inkjet printers are technically CMYK (most are even CcMmYK with additional light Cyan and Magenta inks) printers, their interface is strictly RGB to the user. We rarely use the CMYK color mode in our workflow. 2.2.4 GRAYSCALE MODE Photoshop can also work with images in pure B&W or grayscale.



2.3 INTRODUCTION TO COLOR MANAGEMENT Color correction and color management (CM) are some of the most important and difficult areas in digital photography. We do not claim to be the ultimate experts on this subject, but we would like to share what we have learned. 2.3.1 WHY YOU NEED TO UNDERSTAND COLOR MANAGEMENT If you have a photo on the web and different people discuss its color quality, they will, for the most part, share the following problem. •



Different monitors show the same RGB value quite differently.



•



Therefore, besides the many opinions on color, the viewers actually see different versions of the same photo.



The challenge © 2002 Bettina and Uwe Steinmueller



47



The challenge is having the monitor screen present you with the right impression of how a certain photo would print on a color printer. The new inkjet printers can produce amazing results, but without color management, it remains trial and error. You end up changing the printer’s color settings for every print and with very little satisfaction. So what does color management mean? In our example, it means that the photo you see on the monitor looks very close to the result you get from your printer. This is called "soft proofing".
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Managing The Raw File Workflow The dilemma The dilemma is that every device, be it monitor, printer, scanner or digital camera, has very different color rendering capabilities. If the device renders a certain RGB value, the display of that value on that device will be different from other devices and it might not even be capable of rendering certain values at all. The colors a specific device can render describe a range of colors. Color Gamut is the term used to define the range of colors captured or displayed by a device. The basis of color management is the standardized description of a device called an ICC profile. An International Color Consortium (ICC) color profile is the color characterization of your particular digital equipment. You either get these profiles from the device manufacturer or measure them with special calibration hardware. Note: A RGB value by itself does not define an absolute color Most people use the monitor as their "soft" proofing device. This is why the first step towards complete color management is the calibration of the monitor. Be aware that room lightning and even your clothing influence precise calibration. Adobe Photoshop comes with a utility called Adobe Gamma that lets you calibrate your monitor. Although this is better than not doing any calibration, the use of a hardware calibration device gives much better results and is highly recommended. We have used the following tools: GretagMacbeth Eye-One Display and the Sony Artisan monitor (which provides an integrated solution with a monitor and a special measuring device). Turn the monitor on for a minimum of 30 minutes before starting any calibration. To do the calibration follow the instructions provided with the tool. Do not change any monitor settings without re-calibrating. The recommendation for re-calibration is about once a month. Profiling LCD monitors can be very tricky and the success depends on the tool and the monitor brand. Current LCDs like the Apple Cinema Display are used in the industry for serious color work. Continuing, we have some image RGB values (CMYK is excluded from this discussion). Using monitor and printer profiles will map these values to the monitor and printer. This works for this single monitor/printer setup, but what if you send the image file to a different person. That person would © 2002 Bettina and Uwe Steinmueller
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need your monitor profile and then map it to their monitor profile (which is certainly different). You can see that this would not work in the real world, as we would end up with an inflation of individual profiles for all kind of devices.
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Managing The Raw File Workflow The solution The International Color Consortium (ICC) solution for the dilemma is the introduction of standardized color spaces. These are are mathematical coordinate systems (three-dimensional representation) for assigning numerical values to colors. There are many ways to define such spaces, each with its own benefits and problems. (e.g. Adobe RGB (1968), sRGB, Pro Photo RGB, ...). Hence, a color space is a color gamut, which is the limit for a set of colors. Adobe RGB, sRGB, and Pro Photo RGB are well-defined color spaces, which might not match any device in the world. Using the color space Adobe RGB (this is the one we use) the solution is the following. The image internally stores all RGB values in relation to the internal (abstract) color space (here Adobe RGB). A RGB value in the context of a color profile/space actually defines an absolute color. Photoshop's ICC engine now translates all these color values from the internal space to the monitor space (using a monitor profile). The same happens with the printer. Note: A RGB value in the context of a color space does define an absolute color Repeating this process when receiving a sent image solves the problem of different monitors not showing the same color.
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Managing The Raw File Workflow



2.3.2 COLOR WORKING SPACES Photoshop stores the information about the profile within the image (TIFF, JPEG). Avoid applications that do not use or create these embedded profiles and also do not support the use of monitor profiles. The standardized color spaces range from narrow to broad. If your image is used with a narrow range then some colors get lost in the transformation. Broadening the range to "invent" the missing colors is not possible. If the range is very wide, you deal with colors that probably none of your target devices will be capable of rendering. The following list shows some of the most important color spaces: •



sRGB: This space is still narrow but is supported by some printers. It might be a good idea to use sRGB for photos on the WEB.



•



Adobe RGB (1998): This is a very popular space among Photoshop users. It covers most printable colors. This is what we use.



•



Pro Photo RGB: Color space supported by Kodak (very wide gamut).



•



Apple RGB: Not as wide as Adobe RGB.



Properly displayed color spaces use 3D charts. The industry also uses some form of 2D charts to display color spaces.
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Managing The Raw File Workflow Below is a color space plot that we generated with GretagMacbeth Profile Maker Pro 4.1 Profile Editor.



Gamut Display (using Profile Maker Pro 4.1 Profile Editor) Pro Photo RGB is extremely wide Adobe RGB (1998) much smaller and sRGB is very narrow The color space of the Hahnemuehle German Etching water color paper exceeds sRGB but fits into Adobe RGB The color space of the Epson Luster paper has a much wider range than the water color paper (no surprise here) and exceeds both sRGB and Adobe RGB (in some blues and greens) 2.3.3 PROFILES FOR DEVICES Monitor By now, it should be clear that high-quality color management starts with the best possible monitor profile. Without accurate profiling of your monitor, your workflow will be seriously limited. © 2002 Bettina and Uwe Steinmueller
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Camera In addition, profiles for your camera are very important. There are two types of profiles;Camera generic, and specific profiles for individual cameras. Adobe’s Camera Raw 2.0 and other raw converters are carefully profiled and support generic camera profiles. Be aware that creating your own camera profiles can be very tricky, since the targets have to be shot under very controlled light conditions. There can be some significant variation between individual cameras of the same model. This will depend on specific camera brand and model. Printer There is actually no single profile for a printer. The profile is always for one paper, using the same ink set, printed on the same individual printer and with the same printer driver and settings (e.g. DPI) . Profiles for different types of printing paper can vary significantly. Some of the newer inkjet printer may vary very little from one individual printer to the other, but in general profiles may need to be generated for the individual printer itself. 2.3.4 PHOTOSHOP COLOR AND MONITOR PROFILE SETTINGS Photoshop is not intuitive when it comes to finding the monitor profile that it uses. Select Edit->Color Settings and use the RGB drop down list to select working spaces and scroll (usually up) until you find the entry "Monitor RGB" (the Figure shows Sony_LCD_Std_D65). This entry indicates the monitor profile used by Photoshop. Close "Color Settings" dialog box by clicking on the “Cancel” button to avoid changing your working space settings.
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Finding the Monitor Profile in Photoshop The following screen capture shows how we setup the “Color Settings” in Photoshop (the most relevant settings are marked).



© 2002-4 Bettina and Uwe Steinmueller



55



Photoshop Color Settings Note: We ignore the settings for CMYK and Gray here as we only cover the RGB color setup in our workflow This section is not a replacement for Photoshop documentation, book or training. Although we cover a lot of ground, we will only introduce the main tools we regularly use in our digital workflow.
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2.4 BROWSE YOUR PHOTOS The new Photoshop CS File Browser is the main interface to your images.



Photoshop CS File Browser The Photoshop CS File Browser uses the Camera Raw plug-in to create thumbnails and previews for many supported raw file formats. The EXIF metadata are also shown on one pane. The CS File Browser can create high resolution previews (1024 pixels wide). We will cover later how to use the File Browser with Camera Raw 2.0. To open any of the files you only need to double click on any of the thumbnails. 2.4.1 OPENING FILES BY DROPPING THEM ONTO PHOTOSHOP If we sometimes use an external file browser, we just drag/drop the file from the file browser onto the open Photoshop application. Why would one want to use an external file browser? We use ThumbsPlus for many other tasks, as we will explain in our chapter on archiving. Some are: © 2002-4 Bettina and Uwe Steinmueller
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•



Full Screen slide shows



•



Archiving of external media (CDs and DVDs)



•



Use of multiple open file browser windows



2.5 SIMPLE IMAGE ROTATION One of the first operations you might need to perform is rotating the image. This is needed for all photos that are taken in portrait mode and have not already been correctly rotated (either in the file browser or the raw converter).



Simple Image Rotation The operation is easy and fast using the Image->Rotate Canvas menu item and can be performed 90◦ CW (clock wise), CCW (counter clock wise), 180◦ or even at arbitrary angles. Some new cameras support auto rotate by having an extra sensor that tracks the camera’s orientation. We hardly use this feature as we sometime tilt the camera intentionally and the camera gets fooled. But if you use portrait shot often then make use of this camera feature.



2.6 INSPECTING YOUR IMAGE Open an image that is larger than can fit on your screen. © 2002-4 Bettina and Uwe Steinmueller



58



The image window header information



Photoshop CS window header information



The window header holds valuable information about the current state of your photo (we use this example here): •



File name: x02_0005_1091.NEF



•



Magnification: (25%)



•



Active Layer Name: Dust Layer



•



Color Mode: RGB



•



Bit Depth: 8 bit



•



Soft proofing profile used: Epson2200RelCol



Changing the magnification You can use the Navigator palette to change the magnification, but it is more efficient to learn a few shortcuts: •



Ctrl+0: Fit to Screen, used for general work



•



Alt+Ctrl+0: 100% size, show actual pixels, used for close inspection (e.g. sharpening)



At 100%, use the space bar to activate the Hand Tool and move the image inside the window (of course, it only works if the window is smaller than the image).



Different screen modes Now try to use the ‘F’ key to toggle (3 steps) between the different screen modes: •



Standard screen mode: Photoshop shows all the controls, menus and multiple image windows
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•



Full screen mode with menus: Photoshop only shows the current photo and uses the full screen (50% gray background). Using the Fit to Screen (Ctrl+0) view gets you now a much larger view.



•



Full screen mode: Not even the menu is displayed and the background is black.



Some palettes may still be in your way and distract you from viewing the full image. Press the Tab key and Photoshop hides these palettes. Pressing Tab again gets them back. Many Photoshop experts use a dual monitor setup to have all tools on the second monitor and only the image on the main one.



2.7 KNOW THE DIFFERENCE BETWEEN 8 AND 16 BIT PER CHANNEL DATA Photoshop knows two data modes: •



8 bits per channel



•



16 bits per channel



2.7.1 WHY USE 16 BITS PER CHANNEL? Many digital SLRs allow 12 bits per channel capture and this is later represented as 16 bits per channel in Photoshop (mostly 16 bit TIFF). If the images coming from your camera were perfect, these 4 bits would not make much of a difference as most printers only use a maximum of 8 bits. However, an image that does not require some minor correction is very rare. Once the saturation or contrast of a color image is corrected, the actual color information is soon reduced (due to rounding errors) by one or more bits. If you started with eight bits, you might end up having only six bits of real color information per channel left. The not so smooth color gradients indicate this loss. Starting with 12 bits ensures there is still a sufficient amount of color information available after even major corrections.
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Note: Stay as much as possible in 16 bits as you can afford (memory, disk space and performance).



The test Here is a test you can perform to experience the 16 bit vs. 8 bit difference. Open a photo in Photoshop, which is in 16 bits. Now perform some curves or levels. When finished changing the levels have a look at the histogram in the “Levels” dialog box.



Photoshop performed in 16 Bit Open a photo in Photoshop but convert it to 8 bit just after you open the file and then do the same curves and levels operations.
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Photoshop performed in 8 Bit In the above figure you see is a histogram with many gaps. This indicates lost data and shows up in an inferior gradient smoothness, or posterization. Note: On the other side these gaps should not make you nervous. If the photo and print look fine, that’s all that counts. Conclusion: Remain as long as possible in the 16 bit mode. Why would you ever use 8 bits per channel if 16 bits is so much better? Using 16 bits: •



Takes longer



•



Needs more memory



•



Creates larger files



•



If you work with versions of Photoshop prior to CS many operations (e.g. layers) are not available for 16 bits/channel



Before Photoshop CS was released, all our work was done in 8 bit layers and we also got good results. But if you have enough disk space, memory and fast processors, 16 bit is the best way to go.
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2.8 CONTROL IMAGE SIZE AND PPI



Image size dialog 2.8.1 PIXEL DIMENSIONS Technically your image size only depends on the pixel dimensions. If you only intend to use your photos on the web, this is all that matters. 2.8.2 DOCUMENT SIZE The document size is the size of your image if you print it. Here the pixel dimensions alone are not enough. It very much depends how much resolution means PPI (pixels per inch) your printer will need. What is the right value for PPI? This depends on the printer and process you use. Some printing services have very strict requirements for the PPI settings. For Epson printers like 2200/7600/9600 we have used successfully 180,240,300,360 DPI. Note: Do not mix PPI and DPI. We are talking here about PPI while you printer will be able to print in DPI (dots per inch). Advertised DPIs of 1440 and 2880 can be confusing. Not a single dot in an inkjet prints defines a colored pixel of an image. The color is actually created by a dither pattern of
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different sized and colored dots. This means that 360 DPI may often be enough for use with most inkjet printers. What happens if you change the width, height or resolution? This depends on the following properties: •



Constrain Proportions: You most likely want to have it checked all the time as otherwise the width might change but not the height. Your image will look distorted.



•



Resample Image: If checked you can upsample or downsample your photo. However, there is a loss of quality involved.



•



Checked: The pixel dimension of the images will change



•



Unchecked: The pixel dimension will not change



Note: Never resample an image if it is not absolutely needed! 2.8.3 SCALING AND RESIZING One of the most common operations on images is upsizing and downsizing. Both are very critical operations and should be taken seriously. 2.8.4 CHANGING PPI If you just change the PPI of an image, you do not change any real image data. This is a very easy and safe operation.
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Changing DPI For just changing the DPI you have to keep the “Resample Image” box unchecked. Depending on the PPI the document size will change but not the pixel dimension. Note: We had have good experience in going down to 180 DPI for our Epson inkjet printers. 2.8.5 UPSIZING IMAGES When you upsize an image to make larger prints, you create more pixels from fewer pixels. This means inventing pixels. Even if modern upsizing software does a good job in guessing details, it is not like having captured more and good pixels in the first place. We try to stay moderate in our demands on the amount of upsizing we want to do.
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Changing PPI Photoshop CS supports two different methods that are useful for upsizing •



Bicubic: Classic Photoshop upsizing too. We only use it for minor enlargements (1.5x)



•



Bicubic Smoother: This is a new upsizing option introduced first in Photoshop CS and should be used with larger upscaling.



There are many other good tools on the market and all have their merits. We think you can go a long way with just Photoshop tools but if you plan to do major upsizing jobs often, then you have to check what tool fits best for you.
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2.9 SELECT THE RIGHT IMAGE FILE FORMATS We will only cover the file formats that are most relevant to digital photographers. 2.9.1 TIFF TIFF is a standard image format that comes in 8 and 16 bit variations. TIFF is a lossless storage format. That means you can open and save a file in TIFF as often as you like without changing the quality. TIFF can be compressed (lossless). Photoshop and other imaging applications normally do not have problems opening these files. However, there are still some applications out there that cannot open compressed TIFFs. Photoshop CS now supports ZIP compression (is slower though). 16 bit layered files will compress better using ZIP compression. Tip: Use compressed TIFF when working with Photoshop and save uncompressed if interfacing with other unknown third party tools. TIFF files can also save Photoshop layers. TIFF is clearly the format of choice if it comes to image quality and flexibility. Note: Canon names their 1D/1Ds raw files TIFF as well, but they are actually raw files and can only be opened in Photoshop CS through the Camera Raw 2.0 raw converter. This has cost a lot of confusion by photographers and also imaging tools. 2.9.2 JPEG JPEG files offer great compression. JPEGs are the files of choice for the web and file transmission over slower lines. Most JPEG compression is lossy, so the quality suffers (especially saving/opening multiple times). JPEG also only supports 8 bit files and no layers. Photoshop numbers the compression from 1-12: • © 2002-4 Bettina and Uwe Steinmueller



11-12 very high quality and low compression, hardly any loss 67



•



9-10 decent quality and better compression



•



7-8 ok quality and even more compression



•



1-6 we never use that strong compression



Note: Never use JPEG for photos that should keep their optimal quality. 2.9.3 JPEG 2000 Offers many improvements over JPEG but is not really in the mainstream right now. You can install a Photoshop CS plug-in to work with JPEG2000 files (on the CD). 2.9.4 PHOTOSHOP PSD Photoshop PSD was our format of choice when we saved images with layers. With Photoshop CS we use TIFF with all layered files, since the compression can be better (especially 16bit).
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2.10 FILE INFO AND HISTORY 2.10.1 FILE INFO The Photoshop CS File Info dialog (File->File Info) can display a lot of information about your current image. If you use Camera Raw 2.0 for your raw conversion you can also inspect many camera and conversion parameters. Do not get confused because some parameters are displayed twice. This happens because the camera manufacturers use different tag names for the same camera properties.



Photoshop File Info Dialog 2.10.2 FILE HISTORY We setup Photoshop CS Edit->Preferences->General that Photoshop records all operations done with our images in the metadata of the files (mainly TIFFs). © 2002-4 Bettina and Uwe Steinmueller
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Photoshop History Log setup We can later inspect what operations were performed on this file by using File->File Info->History:
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Photoshop File History The file history is a very powerful option but we hope to see some nicer formatting in the next version of Photoshop (at least on the PC).
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2.11 DYNAMIC RANGE, CONTRAST AND BRIGHTNESS One of the key goals in your workflow is to optimize contrast, brightness and saturation. 2.11.1 IMPROVE YOUR IMAGE WITH LEVELS Image->Adjustments->Levels (Ctrl+L a shortcut to remember) is the main tool in Photoshop to control contrast by adjusting the white, black and brightness. The histogram displays 256 levels of grayscale (0 = black to 255 = white) present in the image. If the image represents a range from black to white the histogram should stretch over the full range.



Levels with Histogram The analysis of the above histogram shows that the range below 25 and above 198 is empty. Enhance the photo’s contrast by setting the left (black) triangle close to 25 and the right triangle (white) to just above 198. The contrast of the image increases, and the colors will show up as more saturated. Most importantly, check whether these corrections really improved the photo and meet your intentions. This operation maximizes the dynamic range used by the corrected image.
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Levels Corrected Here is a tip we got from our friend Phil Lindsay: “Maybe a caution about using the right highlight slide. I have found that it is very easy to throw away (clip) delicate highlight detail. Simply moving the slider to the beginning of the right side of the histogram curve can cause the problem”. We second Phil’s observations. Never try to create a too strong contrast, as removing contrast is much harder than adding contrast. There is also one psychological effect to consider. If you compare two versions of the same image and one has more contrast, the image with the higher contrast draws more attention. This does not mean it looks better. Also printing on matte fine art papers (that we only use) cannot reproduce as high contrast as some glossy papers might reproduce. A good way to judge this situation is to use the Threshold mode by pressing the “Alt” key while using the right/left sliders (highlights and shadows).
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Threshold Mode In the Threshold mode you can exactly see which data would get clipped if you set the right/left sliders to certain values. In general you do not want any clipping at all Note: You also can change levels at the different color channels (R, G and B). Be aware that you will change the color of the image though. 2.11.2 GAIN MORE FLEXIBILITY USING CURVES The Curves tool is one of the most powerful tools in Photoshop. Levels only allow linear corrections, while curves allow you to do much more with the image. Mastering curves is not easy but it is well worth the effort. We want to show some uses of curves that are easy and yet very useful. Curves can control all colors (RGB) or only a single color channel (R, G, or B). 2.11.2.1 USE S-CURVES FOR CONTRAST TUNING
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S-Curve - Preview On and Off The above S-Curves enhance the contrast. “S-Curves” are a very powerful tool and make often saturation enhancements unnecessary. Note: You also can lower the contrast by using inverse “S-Curves”. Note: The S-Curve can introduce a color shift. This can be prevented by using the “Fade” tool immediately after the Curves operation, or by using Curves with adjustment layers (see chapter 4).



Fade with Luminosity 2.11.2.2 CONTROL BRIGHTNESS
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We use these kinds of curves to improve the brightness. Try yourself and you will realize that only a small move in the curve has a strong visible impact. Tip by Phil Lindsay: “When in curves, clicking on the very light but important highlight detail will indicate the corresponding position on the curve. I often lock this point on the curve so that I don't lose it during curve adjustments.”



Use a finer grid for Curves Alt+Click on the grid toggles between two modes (a 4x4 grid and a 10x10 grid). We use the finer grid all the time. The Curves dialog can be also be enlarged by clicking



.



Different Grids for Curves



Saving and loading Curves Some curves can be used on multiple images. In this case you save the curves to your “Photoshop Settings” folder and can load them later on demand.
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2.11.3 PHOTOSHOP CS SHADOW/HIGHLIGHT TOOL We consider the new Shadow/Highlight tool in Photoshop CS to be one of the most important new tools for photographers.



Shadow/Highlight Tool There are 4 aspects of this new tool that cover the tonality of your images: •



Toning down aggressive Highlights (not blown out highlights)



•



Brightening Shadows



•



Enhancing the mid-tone contrast



•



Adding some saturation



We set both clipping values to zero to prevent data clipping.
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Let us start with the most important part: the shadows. Shadow/Highlight (SH) brightens shadows depending on 3 parameters: •



Amount



•



Tonal Width



•



Radius



You have to understand that SH does not brighten the whole image globally but relative to the context in which some pixel exists instead. The radius is the area in pixels where SH looks whether a certain pixel needs brightening or not. The true algorithm is of course proprietary to Adobe, but it can be seen that SH also tries to keep the context restricted to objects. This means that a dark phone line does not get brightened just because inside the radius is a bright blue sky. The tonal width determines how gradual the brightening occurs. Then finally the Amount influences the strength of the effect. Yes, this is a complex control but much easier to use than it sounds. Start using our default values and go from there (shown in the dialog screen shot above).



Highlights The settings for the highlights work the same as for the shadows just in the opposite direction. The highlights get toned down.



Mid-tone contrast The mid-tone contrast slider is a dream comes true. With it, you can control the contrast and restrict it to the mid-tones. •



Color Correction If this slider is set to zero, the contrast enhancement does not shift colors. Sometimes you may want t the contrast to enhances saturation. This slider allows you to do this. Only the changed part of the image will get slightly more saturation.



•



Saving/Load/Default settings
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You can save these settings and load them later. You should also save a setting as the default and use it as your starting point. Our settings are shown in the SH dialog. It is advisable that you use Shadow/Highlight in 16 bit mode. Note: SH can produce halos at high contrast edges. Try to minimize this effect by staying at low radius values.
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2.12 THE ART OF SHARPENING All digital photos require sharpening. Especially since the AA filters in most digital SLRs blur the image to decrease color aliasing. Sharpening is one of the most difficult and subjective topics in digital photography but the available tools are improving. The sharpening process has a built-in contradiction: While giving the impression of sharpness improvement the viewer must be aware that some smaller details might get lost during this process. That is why the targeted viewing distance is very important. 2.12.1 USM (UNSHARP MASK) The classic tool for sharpening in PS is USM (Unsharp Mask). It is also important to be aware that it is difficult to judge sharpening on the screen. A photo that looks hopelessly over-sharpened on the screen might be exactly right for some inkjet printers. Sharpening Artifacts should be limited to a minimum: •



Halos (white or black borders at edges)



•



Noise will get sharpened as well, making it more pronounced.



There are a lot of sharpening tools out there and it is up to you to figure out your favorite methods. 2.12.2 HOW PHOTOSHOP UNSHARP MASK WORKS The most used tool for sharpening is probably straight USM (Unsharp Mask) in Photoshop and nearly all techniques are a variation of it. To get an understanding of the sharpening issues you need to better understand how Photoshop USM works and its inherent limits.
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Sample Picture (not sharpened) We open the Filter->Sharpen->Unsharp Mask Dialog:



Unsharp Mask Dialog Three factors control USM: •



Amount



•



Radius
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•



Threshold



Amount defines the strength of the new improved contrast at edges; Radius determines how many pixels are involved to build the new edges with higher contrast. Threshold defines “how different the sharpened pixels must be from the surrounding area before they are considered edge pixels and sharpened by the filter” (Photoshop Help) and is needed to avoid sharpening noise too much. Good values are very much dependent on the resolution of the image (PPI / Point per Inch). The higher the PPI the higher values of Amount and Radius can be selected.



Sharpened Image What is the dilemma? You can either sharpen too little or too strong so that the image gets severely damaged by showing light or dark halos
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Image shows strong halos We would caution you to stay on the side of low sharpening. If you images only impress by being sharp then try to work on the content. Here is short story. We looked at some Cibachrome prints in one of Carmel’s top photo galleries. None of the prints in that show was critically sharp. But they all were beautiful. Remember sharpness is only a tool to improve the content. Since the sharpening effect is also a function of the resolution and the printing technology, finding optimal settings can be a lengthy process and needs a lot of experience. There is also a principle limitation to USM: all settings are global for any given image. But you might want to sharpen the skin (smoother) different from the hair (much more crisp) for a portrait. Also avoiding amplifying the noise using plain USM can be tricky. That is why there are a huge number of different sharpening techniques published (most often based on some edge masking) and many Photoshop plug-ins that try to make sharpening easier. Note: There is no simple "one size fits all" solution to sharpening. 2.12.3 THE TWO STEP APPROACH The two step approach is a simple way to get started in sharpening © 2002-4 Bettina and Uwe Steinmueller
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•



Low sharpening in the raw converter



•



Final USM in PS



Once you have a grip on sharpening have a look into the many sharpening tools we show at Digital Outback Photo and pick the technique that fits your workflow and image best. We also have a section on advanced sharpening in chapter 6. 2.12.4 SHARPENING TOOLS In our daily work we use more advanced sharpening tools. There are a lot of sharpening tools out there and it is up to you to figure out your favorite. Here are a few of our favorites. •



Fred Miranda’s sharpening plug-ins: Good value for the money



•



Photokit SHARPENER



•



FocalBlade
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2.13 IMPROVING COLORS 2.13.1 ACHIEVING WHITE BALANCE IN YOUR IMAGES Most of the time we do not really want the right colors, but colors that pleases our eye. This does not mean that we want to mess up the colors that we photographed, but that we like the colors sometimes cooler/warmer and with more/less saturation. The key to better colors with digital cameras is actually to get the White Balance (WB) and the contrast right. We will also cover WB later in our chapter about raw conversion. Here are the usual steps: •



Correct WB in the raw converter or on your JPEG image



•



Get the contrast right (also improves saturation in many cases)



•



Optimize local colors with the Hue/Saturation tool



•



Fine tune the color mood (warmer/cooler) with Photoshop CS Photo Filters



2.13.1.1 CORRECTING THE WHITE BALANCE There are a few different techniques to correct the white balance in digital camera images: •



Click on a gray element



•



Use color temperature controls



•



Use warming and cooling filter simulations



•



Automatic White Balance



If you use raw files you have most of the time no problems correcting the white balance in your raw converter. 2.13.1.2 CLICK ON A GRAY © 2002-4 Bettina and Uwe Steinmueller
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If your image shows an area that you think should be neutral (not blown out white and deep blacks please, seems to work best with light grays) then you can use a tool like iCorrect Editlab (featured in the tools chapter) to perform a one click WB.



iCorrectEditlab You just click with the eye-dropper into an area that you are sure should be neutral and the white balance will be corrected. For optimal results, photograph a test shot with a GretagMacbeth Color Checker (the mini version fits easily into any bag, we have one with us all the time)
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GretagMacbeth mini Color Checker and correct WB by clicking on the second brightest gray from the left. Once you have corrected the test photo, you apply the same settings to the other shots at the same lighting conditions.



2.13.1.3 COLOR TEMPERATURE CONTROLS Unfortunately, the color temperature controls are only available in the raw converters (e.g. Adobe Camera Raw 2.0, Capture One DSLR or Nikon Capture) as the raw data are not influenced by the white balance settings of the cameras (exception Nikon D1 raw files)



Color Temperature Control in Camera Raw 2.0 These tools will be covered in the raw converter chapters. 2.13.1.4 WARMING AND COOLING FILTER SIMULATIONS © 2002-4 Bettina and Uwe Steinmueller
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In case you don’t find a neutral object in your picture and use a JPEG workflow there is still help. Use a plug-in like PowerRetouche White Balance:



PowerRetouche White Balance



Before and after correction The goal is actually not to make the colors absolute correct but make them pleasing. The colors in the original are too cold and in the corrected version maybe slightly too warm but at least more pleasing to the eye. Note: You can see that the color difference is way more visible if you watch the two images side by side. A good practice is to create a duplicate image as a reference to the original image.
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This tool allows you to correct WB either automatically or by using settings that are equivalent to classic photo filters. 2.13.1.5 AUTOMATIC WHITE BALANCE Photoshop and other tools have algorithms that correct white balance automatically. Most of the time these automatic tools are off but it does not hurt to give it a try. 2.13.2 PHOTOSHOP HUE/SATURATION TOOL 2.13.2.1 UNDERSTANDING THE HSB COLOR MODEL The Color Picker is a frequently used tool. We cover it here, as it is the easiest way to understand the relation between: •



Hue (base color)



•



Saturation



•



Brightness



The Hue/Saturation/Brightness model is not an explicit supported model in Photoshop but is used in quite a few places like the Color Picker or the Hue/Saturation tool.
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Photoshop File History The big color square on the left defines a single hue. The hue can be selected with the rainbow like slider right to it or by entering a numerical value from 0◦ – 359◦ degrees. The round cursor on the right defines the saturation and brightness for the single hue value. The more the cursor is to the right the higher the saturation (values from 0-100) of the hue and the more to the top the brighter the hue (values from 0-100). As you can see this color model is very intuitive while most other models are not. The right number fields let you view and enter the same color value in RGB, LAB or CMYK. The field with the # show color setting used by web pages. 2.13.2.2 USING THE HUE/SATURATION TOOL FOR COLOR CORRECTIONS Once the white balance is as you like it you might want to change some colors: •



Blues in the sky



•



Skin tones (e.g. if they are too magenta)



•



Greens
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The Hue/Saturation tool in Photoshop allows you to control such selected ranges of color.



Photoshop CS Hue/Saturation tool The Hue/Saturation tool in Photoshop is very powerful but also complex. This tool works in the Hue/Saturation/Brightness model. Most of the time you want to use this tool on selected color ranges and not the full image. Hue defines a base color (see the hue range at the bottom of the dialog). This hue can be modified by changing saturation and brightness (see also our section about the Color Picker at the end of this chapter). Here is what you can do with the Hue/Saturation tool: •



Shift the hue with the (slider #1)



•



Add or remove saturation (slider #2)



•



Add or remove brightness (slider #3)



All operations can be restricted to color ranges (sliders between the hue display bars). There are two types of sliders: •



Vertical bars



•



Triangle bars
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The colors inside the vertical bars get modified 100% while the range between the vertical bars and the triangles define a range where the effect will become less and less strong. We need these transition zones to preserve color gradients in the image. 2.13.3 PHOTOSHOP CS PHOTO FILTER The Photo Filter is a nice extension in CS. We use it mainly for subtle warming or cooling of images and for our B&W conversion process.



Warming



Cooling Keep the opacity very low, as you only want to make subtle changes. Changes that are more dramatic should have been taken care of in the white balance correction.
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2.13.4 A NOTE ON SATURATION One of the main complaints about some digital images is that they lack saturation. Most often these images are compared to film that uses nearly over the top saturations. In fact, digital files can be very truthful to the real world colors. Before you even think touching some tools to boost saturation get first the contrast in you image right. In most cases this already improves the saturation of your images. In case this is not enough use one of the techniques we cover in the advanced techniques chapters. Note: Our friend Jim Collum even more likely reduces saturation and if you see his images you know why. Have also a look at the section on colorized images in chapter 9 and see observe how beautiful low saturation can be.



Selections are a very important tool in Photoshop. One main reason to use them is to limit a filter or operation to only a specific area. Making good selections can be tricky and time consuming. We want to cover here the main ways to create them, as well as some specific operations with selections. Photoshop selections are very sophisticated. The selection is not a simple on/off operation. Some pixels may be only selected by a certain percentage. Subsequent operations on these pixels are only affected by that percentage. A selection is actually a grayscale image: •



White (255): a pixel is 100% selected



•



Black (0): the pixel is 0% selected



•



50% gray (128): the pixel is 50% selected



•



All other shades (x): some value in between, the more white, the stronger the selection, and the more black, the weaker the selection.
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2.14 MAKING SELECTIONS Why is this necessary? Often an on/off selection would result in abrupt changes from selected to not selected and transitions would look really bad. With the grayscale model, you can create much smoother transitions. 2.14.1 MARQUEE TOOL The Marquee Tool allows you to select rectangular areas. The Marquee Tool is used most often with the Image->Crop menu item.



Marquee Tool Surprisingly enough, you will often need to select the whole image. Here the shortcut Ctrl+A comes in handy. Deselect the current selection can be done using the shortcut CTRL+D. 2.14.2 ADDING AND SUBTRACTING SELECTIONS Often you want to make a selection that is the combination of more than one single selection. This can be done by using the Shift key while adding a new selection.
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Adding a selection area You can also remove parts of the current selection using the Alt key and selecting the unwanted parts.



Removing parts from the selection area You can combine selections created with different selection tools. 2.14.3 LASSO TOOL The Lasso tool allows you to select irregular areas. This requires a greater skill to make good selections and there are often better ways to archive your goal. Sometimes the Magnetic Lasso tool is a better choice as it helps follows the edges. Working with the Lasso tool is much easier if you use tablet for your work and not the mouse. © 2002-4 Bettina and Uwe Steinmueller
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Lasso Tool 2.14.4 MAGIC WAND TOOL Sometimes we use the Magic Wand tool. It lets you select areas around the cursor position that have “about” the same color.



Magic Wand Tool This “about” can be specified by using the Magic Wand tool settings. The most important parameter is the tolerance. The higher the value the more the color can differ to be still included into the selection.



Magic Wand Tool Options You can get good selections by using low tolerance and adding (use the Shift key) multiple (can be many) selections with the Magic Wand Tool. © 2002-4 Bettina and Uwe Steinmueller
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2.14.5 COLOR RANGE The tool we use often for our selections is the Select->Color Range tool.



Color Range Tool You can sample a color in the original image, select a Fuzziness and also add and subtract areas.



Color Range Selection 2.14.6 FEATHER SELECTIONS For some operations you might not want a harsh transition. Here the Select>Feather command can be used. Often Feather values can be as low as 2-4. However, in some cases we will go up to 100-150. © 2002-4 Bettina and Uwe Steinmueller



97



2.14.7 INVERT SELECTIONS Often it is easier to create the inverse selection (e.g. selecting the sky). In this case you use Select->Inverse to invert the selection for your intended use.



Selection Inverted 2.14.8 SELECTION BORDERS It is very easy to create a border around your image. Select All (Ctrl+A) and then use Select->Modify->Border and select a width.



Border Selection Then you can fill (using the Paint Bucket Tool) this border with any color you like. 2.14.9 SAVING AND LOADING SELECTIONS © 2002-4 Bettina and Uwe Steinmueller
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Sample Selection Creating an optimal selection can be time consuming. You may also want to reuse a selection for further work. The above photo is a good example: •



Remove noise in the sky and/or work on the brightness



•



Making different changes on the rocks



For this purpose, it is possible to save a selection (Select->Save Selection) as an “Alpha Channel” (which is actually a grayscale image).



Save Selection As a result, the saved selection shows up in the Channels Palette:
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Selection saved as Alpha Channel You can also load back the selections from the Alpha Channel(s):



Load Selection from Alpha Channel



© 2002-4 Bettina and Uwe Steinmueller



100



2.15 CLEAN UP IMAGES WITH HEALING BRUSH AND PATCH TOOL 2.15.1 RETOUCHING DUST SPOTS Sometimes the CCD or CMOS sensors collect dust. These spots are easy to see in brighter parts of the image (e.g. sky). Here you can use the Photoshop clone tool to copy over the spot with a similar area of the image. Photoshop 7.0 introduced a very sophisticated clone tool: the "Healing Brush". The healing brush melds the source and target areas together and often produces a more pleasing result. Here is a sample dust spot



Sensor Dust Spot Select the Healing Brush tool in the PS tools palette. Then press the Alt key and the source cursor shows up (can be hard to spot if the color of the cursor is close to the background color). You then click in an area where you want to sample patterns to replace the target (here the dust spot).



Selecting the source for the Healing Brush Then you create a brush that is slightly bigger than the dust spot, position it over the spot, and click with the mouse button. © 2002-4 Bettina and Uwe Steinmueller
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Apply Healing Brush The corrected image



Selecting Healed Image This is actually not an easy example as the dust spot sits on top of a cloud pattern and could be improved to better reflect the original pattern. We rarely use the clone tool anymore to remove unwanted parts from a photo. Comment by Phil Lindsay: “Yes, it's true that the healing tool is great but there are still instances in which the rubber stamp may work better; especially if the two regions have grossly different colors.” 2.15.2 PATCH TOOL The Patch Tool uses the same algorithms as the Healing brush, and can be used to remove, or move, areas in your picture. We use it here to remove the same dust spot. This time we use the Patch Tool. The first step in using the Patch Tool is to select the area you want to remove (works like a lasso):
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Patch Tool Selection Then you drag the selected area to a place with a pattern that should replace the source:



Move selection to a replacement source The result is close to our first attempt:



Result after Patch Tool use Sometimes you need to use the Healing Brush for a final touchup of the patched area.
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2.15.3 USING SELECTION WITH THE HEALING BRUSCH Here is a spot on the CCD (actually residue from canned air, ouch):



Major spot Here the use of the healing brush is tough. •



Work at about 400% magnification



•



Select the area with a rectangular marquee that you want to protect from the healing brush and invert the selection



Protect window •



Now the healing brush is restricted to the selection and would not interfere with the areas that are not selected (in this example the window).



After some more work we get a final result that looks like this:
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”Healed” image This is not really perfect work but would not be seen in smaller to midsized prints. This is a good example how the healing brush can save your day.
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2.16 IMPROVE YOUR WORKFLOW WITH ACTIONS If you have found your optimal digital workflow there will be many tasks that you repeat over and over again. That is why Photoshop allows you to record such tasks and repeat them on demand.



Action Palette Before we start, have a look at the basic recording tools.



Action Button Bar From the left: Stop recording Record button: shows “red” if Photoshop records an action Replay action Create a new action set Create a new action Delete action or action step
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2.16.1 YOUR FIRST ACTION Open an image for your first action. You create a new action set by pressing . Action sets are folders that help you organize your actions.



Create a new Action Set Select the newly created set and start recording the new action by hitting the button. Photoshop will ask for an action name. Chose a meaningful name that reflects the operations that you are performing. This helps you later to understand what your actions are supposed to do.



Create a new Action Now the red indicator for action recording is on. In our example we use Curves to brighten the image (Ctrl+M).
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Brighten Image with Curves button to stop the recording. Now you should see this in Then hit the your action palette:



New Action shows in Action Palette button and see that Photoshop The new action is ready for use. Hit the repeats the recorded tasks. Create a couple of actions and see how easy it is. 2.16.2 OPEN DIALOGS INSIDE ACTIONS But what if you want to use the recorded Curves values only as initial values and then be able to change them when you replay the action?



Action will open the Curves Dialog
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Click on the second from the left little square at the “Curves” entry. The next time you replay the action the Curves dialog will pop up so that you can make changes if needed. 2.16.3 SAVING AND LOADING ACTION SETS You can save any Action Set (use the action menu accessed by the little triangle at the action tab) to your disk. It is best to keep the file name the same as the action set name. If you load it, the action set will be named after the filename. Later you can load the action back into Photoshop (even on different machines). Loading actions is even more important than saving them, as there are many free and commercial actions available on the Internet. Note: Do not use the “Reset Actions”, “Replace Actions”, “Clear All Actions” menu commands as they may delete all your actions in you actions palette (unless you exactly understand the implications). Sometimes actions get refined over time. In this case it is good practice to add a version name to the Action Set name (e.g. “My Sharpening V1.2”). 2.16.4 ADDING NEW STEPS TO YOUR ACTION Later you may want to add a step to your action. This can easily be done. and record a new step (e.g. Levels). Then Click the action record button stop recording . We now have:



Step added to Action 2.16.5 REARRANGING AND DELETING STEPS IN ACTIONS What if we want the Levels to perform first and then the Curves? No problem, as you rearrange the steps by drag/drop of the selected steps:
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Rearranging Steps To delete steps, just select a step and drag it to the wastebasket



.



2.16.6 CHANGE THE SETTINGS FOR A SINGLE STEP Sometimes you want to change the settings for a single actions step. Double click on the action step entry and the corresponding dialog pops up. Now change the values and confirm. The settings are changed but, in addition, this step was also performed on your open image. Undo the step by Ctrl+Z or using the History Palette.
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2.17 THE POWER OF PHOTOSHOP HISTORY Working with Photoshop history is like “Try before you buy”. You try some steps and go back with no regret.



Photoshop History Palette Photoshop has one of the most sophisticated undo mechanisms available in any application. Depending on the properties settings, Photoshop records the last steps (we allow 25). You can step back to any of these recorded steps and if you do not change anything again, forward to your current state. Thus history is not only useful to undo changes but also to compare before/after scenarios. You could allow more undo steps but this might consume more memory and scratch disk for Photoshop and may slow down your work. The History Palette button bar



Photoshop History Palette : Create a new document from current state : New Snapshot : Delete current state
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2.17.1 SNAPSHOTS If you want to keep a state for later in you session you can create a snapshot.



Photoshop History Palette Snapshots are not deleted when your history removes states that are more than your maximum (in our case 25) number of steps old. They are very helpful if you want to try different variation and do not want to lose one of them. 2.17.2 PURGE HISTORY There is no free lunch and the wonderful history feature uses up memory and also disk space. Sometimes it makes sense to purge all the history to win back performance. Purge does not delete snap shots and also cannot be undone.
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Digital Photography Workflow Handbook



CHAPTER



3



3 USING RAW CONVERTERS



Camera: Kodak 760
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3.1 THE RAW WORKFLOW Here is a diagram of the whole principle RAW file workflow:
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3.2 PRINCIPLE WORKFLOW STEPS 3.2.1 RAW CONVERTER RESPONSIBILITIES There are actually two extreme schools of RAW conversion strategies, and all RAW converters fall somewhere in between: •



Linear conversion: Performs only the interpolation, Exposure Correction and White/Gray Balance in the RAW converter (maybe some noise removal) and the rest in PS using actions, plug-ins or automation.



•



Full Service Conversion: Does all the jobs in the RAW converter. PS is only used for final retouching (dust removal, minor corrections)



Linear Conversion We mention linear conversion here as the term is used quite often in the context of raw converting. We do not feel the need to use linear conversion with C1 or ARC 2.0. However, every raw converter needs to master this step anyway. The linear conversion only performs the RAW interpolation, Exposure (EV) and White Balance (WB). The result is a dangerously dark image.
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Linear converted file This looks like a very poorly exposed file. But all(!) interpolated RAW files look like this if only the interpolation (Bayer demosaicing) had been performed. To bring this image to life a so-called "tone curve" is applied.



Tone Curve This is not really the kind of curve one would use every day.
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Resulting image after profile and tone curve have been applied. 3.2.2 RAW CONVERTER ESSENTIALS



Interpolation (Bayer demosaicing) - Essential This is the key responsibility of the RAW converter. There are many differences in the quality of RAW interpolation (and many different algorithms): The balance between detail and noise removal is a tough tradeoff every raw converter has to face. In light of this, no raw converter will make everybody happy. I prefer a clean image (at low ISO) and can live without some micro detail. Overall, most available raw converters perform this job well enough today.



Camera Profiles and Tone Curves - Essential A RAW converter should come with good generic camera profiles for all cameras supported. A camera profile describes the color characteristics of a certain camera type. Good profiles can be very subjective. The most accurate profiles do not always deliver the most pleasing results.
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A good tone curve should open the shadows without losing too much contrast and exposing shadow noise. Some raw converters allow to add your own profiles (or to modify the delivered profiles). Also with camera profiles there are again two schools: •



Some believe generic profiles do a good enough job most in most cases



•



Only camera specific profiles deliver best results



We think we can live with good generic profiles as delivered by most of today’s raw converters (ARC and Capture One DSLR). But we expect in the future even support for scene specific profiles. The problem with camera and scene specific profiles is that making a good profile is a challenging and complex task.



White Balance (WB) - Essential
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WB in ARC 2.0 Good white balance support is crucial for any useful RAW converter. There are two kinds of WB correction techniques: •



Gray balance by clicking on a neutral spot in the photo



•



WB correction controls (mostly in terms of presets and/or color temperature)



Good white balance support is not a trivial task for any RAW converter. We expect today that a good raw converter can preview the WB correction in real-time (e.g. Nikon Capture, Bibble, Adobe Camera Raw, Capture One DSLR, Sigma Photo Pro) Note: Many raw converters have a single color temperature slider (measured in Kelvin). These raw converters oversimplify the situation of colorcast. In many lighting conditions, especially y outdoors, the colorcast cannot be described by a single slider. Adobe Camera Raw and now also Capture One DRSL provide this slider by allowing you to modify tint/tone as well.
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Exposure (EV) - Essential



EV Correction in 1



EV in ARC 2.0 Good exposure compensation is essential. The tools should be aided by a histogram or equivalent, with under- and overexposure indicators (watch also for overexposure in a single RGB channel). Overexposure is harder to recover than underexposure. Once the values are clipped in the highlights (can be per RGB channel) there is no way to correct it. Control you exposure to avoid overexposure all the time. Exposure controls are standard with all raw converters we know.



Noise removal (NR) - optional (some NR may be essential) Generally, it is a good idea to remove the noise as early as possible before it is amplified in subsequent steps. The noise removal routine can make use of © 2002-4 Bettina and Uwe Steinmueller
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metadata like ISO and camera model. We expect that there will be major improvements on noise removal over the next months and years. Currently the best noise removal tools for high ISO images seem to exist as external tools or PS plug-ins. Noise removal normally also lowers the sharpness of the image and that is why noise removal and sharpening are very much correlated.



Moiré removal-Optional Sometimes noise and artifacts are treated as the same. Here is our view: •



Noise is a result of the image capturing process especially in the shadows



•



Artifacts are the result of the Bayer pattern limitations and the interpolation process



Removing moiré can be difficult or even impossible at times. We use a simple PS technique to remove minor Aliasing. 3.2.3 OTHER IMPORTANT FEATURES



User Interface experience Good raw converters are very interactive (e.g. for WB and EV corrections). Here a good UI helps to better manage your workflow. ARC 2.0 and C1 sport both good user interfaces.



Color Management – essential ARC and C1 provide full support for color management. •



Support for Monitor profiles ARC and C1 use the system monitor profile like PS.



•



Tagging output files with profiles Every file you get as output of the raw converter should be tagged with a working space profile (choices of sRGB and Adobe RGB 1998 should be available at a minimum). In some cases the Canon FVU
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does not tag the converted files. ARC and C1 tag all files with the Output Destination color space.



Histogram – Essential



Histogram in C1



Histogram in ARC 2.0 To help better to judge exposure the raw converter needs to display a histogram. To fully judge proper contrast and color balance, a histogram that displays all three RGB color channels is necessary.



Reasonable large preview - essential There is no way to judge (except to discard the file) a file based on a small thumbnail. You need to have a reasonable large preview to check basic © 2002-4 Bettina and Uwe Steinmueller
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sharpness, contrast, saturation and color. C1 and ARC can get you quality previews fast. Real-time EV and WB correction support can greatly improve the time spent in your raw workflow.



Batch capabilities - essential For some types of photographic work, many photos can have the same WB and EV corrections. In this situation, batch processing is a timesaver. Many raw converters support batch processing. In Capture One DSRL LE the batch is limited to 20 files though.



Good workflow integration - essential This is a very subjective criterion. I describe it as: how the workflow “flows”. Why? Because with early raw converters and some still today the workflow feels more like “bumping” through it. For us workflow integration is key for a raw converter. We think that today Capture One DSLR (fastest previews, background processing and real-time corrections) leads the pack, but also ARC 2.0 with the new Photoshop CS file browser has come a long way.



Integration with RAW image browser - essential It is very important that the raw converter supports a good raw file browser. Here most raw converters do a good job today. 3.2.4 SOME MORE USEFUL FEATURES



Saving and recalling settings or setting groups (like WB, Sharpening, ..) - Essential Very often, you want to apply settings from one image to a group of other images. This feature should be supported by good raw converter.



Upsizing - optional For larger prints, there is a need to upsize the image. If you aim for larger prints some raw converters can do an excellent job upsizing the images at this early step. Upsizing in ARC 2.0 is excellent and should be used if you know that you want to print big. © 2002-4 Bettina and Uwe Steinmueller
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Cropping - optional Cropping in the raw converter can save some time in your workflow.



Summary Here are the most important criteria for a good raw converter



*



Full support for Color Management



*



Image Quality (very subjective though)



*



Real-time EV and WB correction



*



Fast and sufficiently large previews



Camera Raw 2.0 and Capture One DSLR satisfy all of these criteria and support a good workflow.
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3.3 ADOBE CAMERA RAW 2.0 (ACR)



There is no doubt that only raw files deliver the maximal possible quality a camera can deliver. Unfortunately, all these raw file formats are different and non-standard (that will hopefully change over time). Now Photoshop CS can open many of the existing raw file formats. Note: We are aware that there are variations between individual camera color spaces but these differences are not as big for some camera models as some might believe. That means generic camera profiles can be very useful. Adobe's Camera Raw 2.0 changes this situation quite a bit. Now most of the raw file format can be opened using a common user interface. Camera Raw provides careful generic profiling for all supported cameras . Here is the impressive (not complete) list of cameras supported right now (we list only those digital SLRs we have used): © 2002-4 Bettina and Uwe Steinmueller
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•



Canon D30, D60, 1D, 1Ds, 10D, 300D



•



Nikon D1, D1x, D1h, D100



•



Fuji S2



•



Olympus E20



•



Kodak 760, 14n, ProBack & ProBack 645 (ACR opens these files but they are not officially supported by Adobe. We actually get very good results from ProBack files)



It is kind of needless to say that everything in Camera Raw 2.0 (ACR) is fully color managed (monitor profiles are the same as used by Photoshop and for all supported cameras Camera Raw uses built in generic camera specific profiles).
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3.2.1 INTEGRATION INTO THE PHOTOSHOP CS FILE BROWSER



Photoshop File Browser using Camera Raw The Photoshop CS File Browser uses Camera Raw to create thumbnails and preview images for all supported Raw file formats. The preview images are high quality and 1024 pixels wide.
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3.3.2 CAMERA RAW 2.0 USER INTERFACE OVERVIEW



The user interface of Camera Raw is clean and easy to use. The window can be resized up to full screen. The only downside of full screen is that some operations might be less real-time than using a smaller window (this depends of course on the performance of the machine used). We use a window size that is quite big and Camera Raw still performs well in practical real-time. The preview image is big enough to judge the color and other details. If you need to view finer details, the preview can be zoomed to 100% pixels and beyond.
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3.3.2.1 THE USER INTERFACE ELEMENTS



The Histogram



The histogram shows a RGB histogram and histograms of the three color channels.



Zoom/Hand tool ACR supports all the usual zooming and image moving controls that you are used to in Photoshop. Most of the time we have the preview set to "Fit in View" as we do most detail inspections later in Photoshop itself (but that is our personal workflow style).



Eyedropper We will explain the eyedropper later when we cover WB (White Balance). The Eyedropper can also be used for some RGB readouts that are then displayed on the right side below the preview window.



Rotating There are two controls to rotate the image clock or counter clockwise.



Options
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The preview checkbox toggles between the current settings and the default settings for the camera.



ICC Working Space



ACR offers four different working spaces. We use Adobe RGB (1998).



Bit Depth You can open Raw files with ACR in 8 and 16 bit mode. Most of the time use ACR in 16 bit mode.



Output Size



For most raw file formats, ACR allows you to up/downsize the image. The algorithm used is much improved over the standard Photoshop "bicubic". "(-)" indicates a down sampling from the native camera format and "(+)" an upsampling.



Resolution This defines the PPI that the opened file gets tagged with. We work with the standard s of 240 or 300 DPI. You will not change most of these options that often once you use Camera Raw regularly.
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3.3.2.2 CAMERA RAW'S MAIN CONTROLS There are two modes:



•



basic



•



advanced



We will only cover the advanced mode. We probably could live with basic mode most of the time but also don't get confused by the more options of the advanced mode.



The advanced mode offers 4 tabs with controls:
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ACR 2.0 main controls •



Adjust



•



Detail



•



Lens



•



Calibrate



We will discuss these tabs in more detail.
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Adjust Tab The Adjust tab holds the essential controls used for any raw conversion.



Adjust Tab The main tasks you do in any raw converter are correcting your White Balance (WB) and Exposure (EV).



White Balance (WB) The white balance in ACR is controlled by two sliders: Temperature and Tint. Here is how Thomas Knoll (the original creator of Photoshop and also of Camera Raw) explains their function: "To get a color to appear white, you need to get three parameters correct. This is a basic feature of human vision, stemming from the three types of color sensors in the eye. © 2002-4 Bettina and Uwe Steinmueller
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There are several common ways of factoring these three parameters. Probably the most familiar is red-green-blue values, where white is when they are all equal to some maximum value. Another common factoring is luminance-temperature-tint, which is what the Camera Raw plug-in is using. Luminance is basically how bright the light is. This is what photographers fiddle with all the time by adjusting shutter speed and f-stop. The Camera Raw plug-in allows you to fine-tune this using the "Exposure" slider. The remaining two parameters describe the "color" of the light. If you take a black object and start heating it up, first it starts to glow red, then orange, then yellow, then "white," and then a blue-white. The exact color of this light is dependent only on the temperature of the object, and is called "black body radiation". It is usually measured in degrees Kelvin. Unfortunately, humans usually describe lower Kelvin numbers as being "warmer," and higher numbers is being "colder," which is opposite what science would suggest. But real world light is rarely pure black body radiation. Tungsten light comes very close to being a pure black body, but other light sources usually have a color that is offset from the black body curve. On one side of black body curve, the light is greener; on the other side, the light is more magenta. Fluorescent lights are often very green. The standardized average daylight values (D55, D65, D75) are all slightly greener than black body. Flashes are sometimes more magenta than black body. The Camera Raw plug-in has two sliders to adjust for the color of the light. The first is "Temperature," which is a closest point on the black body curve to the light's actual color. The second is "Tint," which is the offset distance perpendicular to the black body curve. Positive values means the light is greener than black body; negative means the light is more magenta than black body." We have used nearly all other raw converters out there and practically found that just a color temperature slider does not cut it. We must say that the WB control in Camera Raw is one of the best we have seen so far.
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Of course, Camera Raw also allows a one-click WB. Click with the eyedropper on a gray or white (no overexposed white please) area and ACR sets the correct temperature and tint values. We try to photograph a gray card or ColorChecker under the same light as the other images during a photo session, correct the gray card image and then apply the WB settings to all the other photos with the same light (see saving and loading settings below).



Then there are also some standard WB presets:



Standard WB Presets These presets can be used as a good starting point for manual WB correction (in case you don’t find a neutral/gray object in the image). Please read our section about "Subjective WB" to understand that often the "right" WB needs some subjective corrections.



Exposure & Shadows The exposure slider allows you to control the right settings for your highlights. ACR has a very powerful unique feature to view possible blown highlights. While you drag the exposure slider use the "Alt" key and you get a threshold view (works also in Photoshop Levels).
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Threshold view shows clipped Highlights The shadows slider lets you control the shadows and again the "Alt" key allows you to see a threshold view.



Threshold view shows clipped Shadows The preview and histogram are both updated in real-time.
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Brightness/Contrast ACR also allows you to control the brightness and contrast. We perform the final correction in Photoshop and leave these two sliders at their default values most of the time.



Saturation The control for saturation works quite nicely. We prefer to tune later the saturation in Photoshop for selected regions and selected colors.



Detail Tab The Detail tab includes controls that handle sharpness and noise.



Detail Tab
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Sharpness You can get quite good sharpening results with ACR's sharpness tool. There are three possible strategies: •



Do all sharpening in ACR (recommended for batch conversion)



•



Do some 10% sharpening in ACR and later final sharpening in Photoshop



•



Leave all sharpening to Photoshop.



We currently tend to use method 3 as we have very good sharpening tools later in Photoshop and want to leave sharpening as the final step.



Here is a Canon 1Ds file as an example



1Ds image (4064x2704 pixels)
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ACR sharpening 0% on the left and 50% on the right (shown at 100% pixels) You also can set an option "Preview images only" to prevent the converted files to be sharpened but still simulate sharpening in the ARC preview. This makes it easier to judge the image while using more sophisticated sharpening techniques later in Photoshop.



We actually have the sharpening setting at zero as we sharpen later in PS (or select sharpen for preview only).



Smoothness Smoothness controls the image noise removal. It can be controlled at two levels: •



Luminance Noise (detail noise)



•



Color Noise (good values seem to be 20-30)



The smoothness control can be used to remove some noise (especially for higher ISO images). ACR tries to keep the sharpness on all edges but as any noise filter the images gets a bit degraded. Our strategy is to use as much as possible low ISO with all our cameras to avoid noise removal as much as possible. Again, the general strategies are the same as with sharpening:
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•



Do all noise removal in ACR (only for really high ISO images)



•



Do some 10% smoothening in ACR and later more work in Photoshop (Neat Image or Noise Ninja)



•



Leave all noise removal to Photoshop.



Again, we tend to use method 3 or in general do hardly any noise removal at all.
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Lens Tab



This tab provides two very unique tools: •



Chromatic Aberration Removal (CA)



•



Vignetting compensation



Lower quality lenses but also some prime lenses used with full frame sensors show mostly in the corners so called chromatic aberration (CA).
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Sample Chromatic Aberration and the fixed result in Camera Raw 2 It shows at high contrast edges. One side will be green and the other side purple. ACR helps to remove (at least minimize) the effect with ease as the tool works in real time. The Panorama Tools (a free Photoshop plug-in for image stitching) also contain a CA filter but is pretty slow and you have to manually try to find the right values. ARC 2.0 CA removal is simply first class and worth the price of the upgrade of CS alone if you get a lot of CA in your images. We did not feel the need to use the vignetting filter yet.



Calibrate Tab
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This is a tool that some will love and others may hate. Some raw converters control the colors for the different cameras by using standard camera profiles and even allow the users to replace the profiles (example Capture One DSLR). This is a very powerful solution if you are able to get "good" (subjective) profiles. Creating your own profiles is not that easy and in our opinion better left to experts. But there are already third party profiles for tools like Capture One DSLR on the market. ARC has hard coded the profiling done for all the cameras. The "Calibrate" sliders now allow you to tweak the profiles defined by ARC. This is very powerful but you better know what you do. We will leave the settings mainly to the default (all 0) but also expect that some photographers will come up with useful settings for the different cameras.
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Saving and reusing settings Often you want to use the same settings for a set of photos. There are two ways in Camera Raw to save the settings and apply them later to other images. Save and load settings (all settings are saved and can be restored).



Once saved into the folder "Presets/Camera Raw" these settings are also shown in the settings drop down list



•



Default: Apply camera type default (see next paragraph)



•



Previous: Recall values from the last conversion done by ACR



•



Custom: User has changed values



•



Other entries: List of user saved settings that are located in the folder "Presets/Camera Raw"



Use "Set Camera Default": in this case, the settings are used for the same camera type as the default if you later open a new image from the same camera (type). This allows you to have defaults e.g. for the Canon 1Ds and the Nikon D1x at the same time. "Reset Camera Default" can be used to get back to the Camera Raw factory (Adobe) default settings.
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We most of the time use a mixture of methods 1 and 2.



Recording the Camera Raw settings Later you might ask how the settings had been when you converted a certain Raw file. No problem: ACR records all the settings used by ACR in the meta information of the created file. You can later use the Photoshop File Browser to read the settings you used and apply them to Camera Raw.



Batch conversion You can also perform batch conversions. This is done by creating Photoshop actions and using these actions in batch mode. It is easy to follow the instructions in the CS manual. You can also use different actions for different purposes. One reason to use batch conversion would be to create some preview JPG images from newly captured photos or if a set of photos has the exact same exposure and white balance (e.g. studio shots).
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3.3.3 ADVANCED FILE BROWSER INTEGRATION



The file browser integration of ARC 1.0 in PS 7 was very limited while the new file browser is optimized for ARC 2.0. This means that the FB will use ARC 2.0 to create thumbnails and preview images that use image specific settings and are processed by ARC 2.0 for all supported raw file formats (many).



To keep track of the settings in ARC 2.0 on a per image basis you have two options: •



Use a compact ARC database



•



have a XMP sidecar file per image
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First we liked the database solutions better as it does not clutter the image directories with extra files. But this solution has one downside that you cannot have the same raw image in two different locations and maintain different settings for both of them. Why would you ever want to do that? Well, we tried to process the same file in B&W and the other in color. From now on we only use the sidecar file solution. In the new file browser you can also apply raw settings from one file to other selected files:



You can either copy all settings or only selected properties (most important the WB).



© 2002-4 Bettina and Uwe Steinmueller



147



You then can select the source for the setting that should be copied. Then all the settings will be applied to the selected files and the file browser will later reflect them in the new thumbnails and preview images.
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3.4 PHASE ONE’S CAPTURE ONE DSLR (C1)



Capture One DSLR There are different versions for Capture One DSLR (C1) that support different function levels and different sets of cameras. Note: Some dialogs may be different but in the end the cover the features we use in our workflow We use Capture One DSLR Pro for our work with our Canon 1Ds, 10D and Nikon D1x, D100 and C1 Rebel for the Canon 300D. There are two features that make C1 a state of the art raw converter: •



Excellent image quality



•



Great raw converter workflow



C1 is fully color management aware, which is essential for any serious color work. The best way to understand C1 is to learn how it works. © 2002-4 Bettina and Uwe Steinmueller
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Capture One DSLR is what we call a “Full Service RAW Converter”. That means you can do nearly all operations for your final picture inside this tool (except retouching like cloning, lens & perspective corrections). Note: The Capture One DSLR RAW conversion is not based on the Canon or Nikon SDK. Phase One uses own algorithms used for their high-end digital backs for many years. Actually, Capture One DSLR is implementing a very productive workflow for its supported RAW files. This section is not a replacement for the manual and we will only cover the main steps and settings. Capture One DSLR would be worth a book by itself. 3.4.1 SETUP Here is some help to setup the preferences.



Preferences Essential settings:
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•



DSLR noise Suppression: We would set it to low or medium/low for lower ISO images



•



Disable sharpening on output. This simulates sharpening on the preview but does not apply sharpening to the output. We influenced this feature as we do our sharpening later in Photoshop but still want to have a preview that looks sharp.



•



We disable the opening of the developed image in Photoshop. Instead we open these files using the Photoshop file browser.



•



Activate the separate RGB channels for the histogram



Color Management setup •



Camera Profile: Capture One offers generic profiles for the supported cameras



•



Working Space: We use Adobe RGB



•



Monitor: Here you need to enter your correct monitor profile (C1 actually checks a mismatch to the system monitor profile)
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3.4.2 RAW FILE BROWSER



Image Browser in Landscape Mode At first, it looks like a nice but quite normal image browser. There are some major differences. •



With the function key F8 the browser can be toggled to work in portrait or landscape mode (to allow the most space for the preview image)



•



The browser and Capture One DSLR (C1) do not use the original RAW files for preview. For preview, C1 creates preview images in the background. Once these previews are created you can switch from one file to the other in near real-time. The downside of this approach is a large disk space you need for the preview cache (can be cleaned in the preferences dialog)



•



C1 allows the user to define permanent project folders. This way you can get to all your current project folders fast. The preview images of these permanent folders stay even after cleaning the cache.
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3.4.3 IMAGE PROCESSING Image processing in C1 is a five step workflow process: •



Inspect



•



Gray Balance your image



•



Correct exposure and contrast



•



Sharpen (called focus)



•



Develop



Inspect



The first thing you might want to do is to look at the photo and the capture information: •



Histogram (best used with the three channel histograms)



•



Data recorded by the camera, like: o ISO o Exposure time and aperture o Lens used
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o Flash



Gray/White Balance (WB)



C1’s Gray Balance tool The main tool for gray balancing is the eyedropper. You select a gray area inside the image and click with the eyedropper. C1 even gets you some hints whether this might be a good spot for gray correction. If there is no gray in the image things get bit more complicated and you should use the color temperature controls (Color Temperature and Tone Balance). Best you take a shot with a gray card or Color Checker (we have one with us all the time) at the same light to make gray balancing easier. C1 also allows additional cast corrections. Because you can save/restore WB settings, you can save some sample settings for the same light conditions.
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C1 also provides an automatic correction. As all automatic corrections, this may not always, what you want. But sometimes it might give you just the result you want.



Exposure



C1 Exposure After WB the exposure is the next most important correction tool. Here you can correct +/- 2.5 EV. The histogram and the preview image (use an option in the toolbar) let you inspect all areas of over/under exposure. Important are the RGB channel histograms as there are often overexposures just in one channel Besides EV, you also can correct the contrast and also tweak the saturation (try to stay moderate). © 2002-4 Bettina and Uwe Steinmueller
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Tone Curves In addition, C1 comes with different tone curves:



For most situations the standard tone curve “Film Standard” will do. If you need more shadow detail, try “Film extra Shadow”. The curve “Linear Response” is mainly for profiling purposes. We also more and more often find the Curves in C1 to be useful, especially to recover some shadow detail but otherwise we leave shadow recovery to Photoshop.



© 2002-4 Bettina and Uwe Steinmueller



156



Focus/Sharpening



C1 Focus The C1 sharpening tool is a classic Unsharp Mask (USM). Do not try to over sharpen your images. As mentioned before we leave the sharpening for later in our process.
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Develop



Develop If you click the develop button (or the Insert key while you are viewing any tab) the real RAW conversion is performed. Again, C1 demonstrates the focus on workflow. How? The RAW processing is done in the background and C1 is free for the next interactive image corrections. Note: Some C1 versions can only have only a limited number of files for development at any time. We work around this limit by working on the developed files in Photoshop. Then we add more to the queue. If this is a limit, then you are most like a real pro and buying the Pro version would save you time and money.
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What’s More? There is actually a lot more to C1. For our personal workflow we are quite happy with the basic functionality we outlined. Studying the C1 help file is well worth the time. •



You can also create own custom camera profiles and use them in C1



•



Export preview images



Note: There are now third party profiles available for C1 and they can make a difference. We use so many different cameras and raw converters that we try to stay with the basics and that is: •



Get the WB right



•



Optimize Exposure
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Managing The RAW File Workflow



3.5 NIKON CAPTURE Nikon Capture is Nikon’s full-featured RAW conversion utility. You have to buy it separately but if you are serious about RAW conversion then you need to buy this tool. Again, this section is not a replacement for the manual. We will only cover features we use for our workflow.



Nikon Capture
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3.5.1 SETUP



Preferences



Selecting the Photoshop directory



You can launch the converted files directly into Photoshop. That is why you select the Photoshop application here. In fact we don not use this feature in our workflow.
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Color Management This dialog box allows you to select the right working space and your monitor’s profile.



Color Management Settings



We use Adobe RGB (1998) as our working space and select the system monitor profile (shown is the monitor profile for our Sony NV170 notebook). You have to restart Capture to make the monitor profile active.
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Managing The RAW File Workflow



3.5.2 MAIN FEATURES Let us assume you have opened a NEF photo in Capture 3 or 4.



Advanced RAW Getting the settings in the “Advanced RAW” dialog box right is essential for your success.



Advanced RAW Dialog



ƒ



We cover EV compensation later.



ƒ



Sharpening can be set to “low” or if you like to “normal”. Normal might sometimes introduce unwanted halos.



ƒ



Tone compensation is set to “normal” or on a photo with stronger contrast to “Less Contrast”.



ƒ



For color mode, we use our working space “Mode II (Adobe RGB)”.



ƒ



We rarely ever use the “Hue Adjustment” or “Saturation Compensation”. If we need to correct them, we use Photoshop for this instead.
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Managing The RAW File Workflow Curves The Capture 3 “Curves” tool is very powerful and we prefer its interface to the curves in Photoshop since Captures also let us see the histogram. But on the other side we try as much as possible to minimize our work in Capture converter and leave the rest for Photoshop.



Capture Curves



Now return to the EV compensation slider in the “Advanced RAW” dialog box. The histogram in the above photo an EV of +1.0 would show the following resulting histogram:



EV +1.0
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Managing The RAW File Workflow As we said before you should limit the modifications in Capture 3/4 and do the rest in Photoshop. In case of a light overexposure, you need to use negative EV compensations. Play with the slider until there are no more spikes at the far right of the histogram. If needed set the Tone settings to “Less Contrast” to recover highlights.



Size and Resolution Most users will not use this dialog box. If we want to print the photo larger than 17” wide, we like to upsize our photos at an early stage (we upsize to a 12MP equivalent). This helps to minimize the effects of degradations occurring later in the workflow if a later upsizing of the photo takes place.



Upsizing In Capture



This permits us to print up to 21” wide at 180 PPI without any further resizing and to increase to 30” with no real problems using Fred Miranda’s SI actions. We were inspired to use this method by Paul Caldwell and the fact that the Fuji S2 RAW converters do the same thing. Tip: Check this method carefully it might not be the right choice for you (and avoid it if you do print smaller than 17” wide).
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3.5.3 WHITE BALANCE (WB) Besides EV the other main task in Capture 3/4 is getting the white balance (WB) correct. There are two ways to correct WB.



Setting the color temperature



WB: Setting Color Temperature



The setting in the above image shows the way we use this dialog box most of the time. Select the light source like “Daylight”, then “Sunny”, “Cloudy” or “Shade” and finally tune the color with the “Fine Adjustment” slider. We are more interested in the subjective color temperature than absolute values. Also our photos very seldom have well defined gray areas to use for method 2.
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Setting the Gray Point



Setting WB Gray Point



Correcting the WB by clicking on a gray object in the photo (e.g. a gray card or ColorChecker) is the method of choice if you need the best objective WB correction and you have a gray area inside your photo. 3.5.4 SAVE AND LOAD SETTINGS Once you have established your settings, save them. ƒ



To save them: From the main menu bar click “Setting” then select and click “Save”



ƒ



To recall them later: From the main menu bar click “Setting” then select and click “Load”



Tip: Save the settings you use most and recall them for each photo you process.
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Managing The RAW File Workflow



3.6 CANON EOS VIEWER UTILITY (EVU) The Canon EVU is a simple raw converter for Canon camera raw files. EOS Viewer Utility is an advanced replacement for Canon’s former File Viewer Utility. The conversion quality is very good but the workflow is kind of simple.



Canon EOS Viewer Utility



3.6.1 SETUP



Preferences



Simple Setup



There is hardly anything to setup



3.6.2 INTEGRATION INTO THE PHOTOSHOP CS FILE BROWSER



Photoshop File Browser using Camera Raw The Photoshop CS File Browser uses Camera Raw to create thumbnails and preview images for all supported Raw file formats. The preview images are high quality and 1024 pixels wide.
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Managing The RAW File Workflow



3.2.2 MAIN FEATURES



Raw File Viewer Window If you select a raw file (double click on the thumbnail) if launches a resizable window with the rendered raw file. The histogram can be in luminance or RGB mode.



Histogram Modes As you can see the luminance histogram does not show the whole story.



3.3.1 INTEGRATION INTO THE PHOTOSHOP CS FILE BROWSER



Photoshop File Browser using Camera Raw The Photoshop CS File Browser uses Camera Raw to create thumbnails and preview images for all supported Raw file formats. The preview images are high quality and 1024 pixels wide.
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3.1.1 SETUP



Preferences



Simple Setup



There is hardly anything to setup



Managing The RAW File Workflow



3.1 CANON EOS VIEWER UTILITY (EVU) The Canon EVU is a simple raw converter for Canon camera raw files. EOS Viewer Utility is an advanced replacement for Canon’s former File Viewer Utility. The conversion quality is very good but the workflow is kind of simple.



Canon EOS Viewer Utility



3.1.6 TONE CURVE



Tone Curve



We hardly would use the tone curve as we would do the corrections later in Photoshop.



3.1.7 SAVING CONVERTED FILES



Save converted file



We save the results to a special folder for temporary converted files. Output should be TIFF (16 or 8 bit). We also keep the names as we rename all files to our standard



3.2 CANON DIGITAL PHOTO PROFESSIONAL (DPP) The Canon DPP is free tool that comes with the Canon high-end DSLRs: 1Ds, 1D and 1D Mark II (it is also planned to support in the future the other Canon digital SLRs). The DPP is Canon’s answer to third party tools that are way stonger in terms of workflow than the older Canon tool. The conversion quality is good and also the workflow is not bad. But still DPP is no quite as elegant to use as ACR, C1 or Bibble 4.



Canon Digital Photo Professional



3.2.1 SETUP



Preferences



Setup



Most important setting is the “Operating Mode”. Standard is the best compromise of working speed and output quality (same quality on output as “Quality Priority”).



Color Management



Color Management



DPP does not detect the system monitor profile automatically but allows you enter it manually. This is essential to get correct color previews on your monitor. As working space we use “Adobe RGB” as with all tools. .
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3.2.2 MAIN FEATURES DPP has three window types: •



Main Window: for browsing thumbnails (see above)



•



Image Editing Window: Editing a selected number of raw files



Edit Image Window



•



Single image editing window



Singe Image Editing Window



The tools to correct and optimize a raw image is split over 2 tool tabs: •



RAW image adjustment



•



RGB image adjustment



RAW image adjustement Panel



RAW Adjustment Panel This panel holds the key controls to adjust your raw files:



•



White Balance (WB)



•



Brightness (EV)



•



Color Adjustment



•



Dynamic range adjustment (Tonecurve)



3.2.3 WHITE BALANCE (WB) Besides EV the other main task in DPP is getting the white balance (WB) correct. There are two ways to correct WB.



Setting the color temperature



WB: Setting Color Temperature



. Color Temperature Presets



We are more interested in the subjective color temperature than absolute values. Also our photos very seldom have well defined gray areas to use for method 2.



Setting the Gray Point



Setting WB Gray Point



Correcting the WB by clicking on a gray object in the photo (e.g. a gray card or ColorChecker) is the method of choice if you need the best objective WB correction and you have a gray area inside your photo. 3.2.4 SETTING EXPOSURE



EV compensation



During EV correction you have to watch the image and histogram very carefully to avoid data clipping (highlights and shadows). Unfortunately the better suited histogram is on the RGB adjustment tab as the histogram here seems to show the linear data. Better to correct the exposure just looking at the image itself.



3.2.5 COLOR RENDERING



Color Rendering



We leave it to “shot settings”



3.2.6 TONE CURVE ADJUSTMENT (RGB TAB)



Tone curve adjustment



This is a very powerful curves tool. We used all controls to demonstrate the flexibility: •



Brightness



•



Contrast



•



All normal curves functions



We would always leave the image kind of soft and make final adjustments in PS using our layer based workflow.



3.2.7 COLORE ADJUSTMENT (RGB TAB)



Color Adjustment



Be careful to use the hue slider. But using the saturation slider may make more sense. We often rather lower the saturation then make the saturation stronger. As explained in the workflow you then should think of a more selective saturation enhancement.



3.2.8 SAVING CONVERTED FILES DPP offers two ways to save converted files: 1. Single image save



Save converted file



Don’t forget to select “Embed ICC profile”. 2. Batch save



Batch Save



This is the option we use as you can: •



Convert multiple files at the same time



•



Select a standard target folder



•



Continue working on the next file as it performs in the background



When the images are processed this dialog shows up:



Unfortunately there is no option that this window closes by itself. Bug (feature) in our current version (6/2/2004): If the image already exists in the target folder the image will not get processed. EVU use would in this case use a different name (e.g. xxxx(2).tif)
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3.1 PIXMANTEC RAWSHOOTER ESSENTIALS 2005 (PC ONLY) If you work with RSE you will realize that the design goals were: •



World class raw conversion



•



Simplicity



•



Easy workflow



Photographer centric (means intuitive use for photographers) We personally regret that there is currently no Mac version, These are business decisions which we do not plan to comment. We still hope for all Mac users that there maybe a version with this technology in the future.



3.1.1 INTRO



RawShooter essentials RawShooter essentials (RSE) looks like a very basic and simple application. Don't get fooled as simplicity is a priority design goal and way harder to make than bloated applications. RSE will be for a limited period of time available for free. The only thing you need to do is to register your application. Sounds like a strange business



model, right? The idea behind this is that as many as possible users give RSE a try and then decide to buy the next version that will add more workflow and imaging features. For the record, we start now using RSE as our main raw converter. This means that RSE indeed contains most "essential" features that we would expect from any good raw converter. Camera raw formats we used: •



Canon D30, D60, 10D, 20D, 300D, 1D, 1D Mk. II, 1Ds, 1Ds Mk. II, Pro 1



•



Nikon D100, D70, D2h, Coolpix 8700



•



Olympus E1, E300



•



Konica Minolta A2, 7D



•



Adobe DNG



3.1.2 GETTING STARTED (SETUP) Note: Even if we cover a lot of details this is not a manual. Also the main principles are covered in our e-book DOP2000. After the installation you have to register and RSE is ready to go. There is not a lot to setup but we did the following:



•



Select the "Batch convert" tab.



Batch convert tab RGB Working space: We use either 8bit Adobe RGB or 16 bit ProPhoto RGB All as shown on the screen shot. This is the first raw converter that we use with sharpening "on". Later we may only add some minor sharpening with EasyS You can also open the converted files directly into Photoshop. We don't use it most of the time as we have a different browser watching the folder with the converted files You can also use own camera profiles. But we think that the internal profiles are quite good. We do not feature how to use own profiles but RSE fully supports such profiles and their creation process (see preferences). Open the "Naming and output location dialog":



We have a special folder for all converted files (here D:\_tmp_workfiles\x_raw_shooter).



3.1.3 THE RAW FILE BROWSER Note: As the name says this is a browser for raw files only. The raw file browser supports quite a few features. First you can select from 5 layouts that you can switch on the fl. We use option #5 in film strip mode:



Different layout options Our main layout looks like this:



Viewing option #5 with film strip mode On the left you find the folder browser and the favorites list:



At any time you can add a folder to the list of favorites (either right context menu or via drag/drop). Favorites are crucial to get fast to your last projects. Once you select a folder RSE will start to create previews and thumbnails. RSE is probably very fast but still using folders with many large raw files will take some time. There are two indicators in RSE that the preview building is still in progress:



Busy indicator wheels



Window top border shows how many previews are still to be created Once the previews have been created the workflow is pretty fast. The film strip area allows organizing your images in different priorities:



Film strip There are 8 tabs on top: •



All images in the folder



•



All flagged images in the folder



•



All images that have no priority and are not marked for deletion



•



Images of priority 1, 2 or 3 (you can easily tag all files)



•



Recently processed images



•



Images marked for deletion (if you then finally delete them they are gone for good)



•



The film strip toolbar allows to control the appearance:



•



Size of the thumbnails



•



Sorting order (name or date)



•



Finally delete the images marked for deletion



For any single image you can perform the following operations on the thumbnails:



•



Flag image



•



Set priority 1, 2 or 3



•



Mark for deletion



•



rotate by 90 degrees left or right



Once we have selected a folder and want to work on a single image we use the full image view (TAB toggles between both views):



Work view You can scale the image up to 800%. 100-400% are pre defined settings:



Zoom presets RSE allows to conveniently toggle between "fit View" and the last selected zoom level by using "Shift + TAB". If you work with zoom levels the navigator panel helps to find the right spots:



Here are the controls for the main view:



3.1.3.1



•



Zoom level



•



Fit to screen



•



Zoom presets



•



Hand tool (better use the space bar)



•



Show under/overexposure warning colors (can also be activated on demand using the Ctrl key)



PREVIEW SIZE RSE provides full sized previews for all cameras. Working with 100% views or larger is also much more convenient than in Capture One (check out the slide show - see below).



3.1.3.2



DELETION WORKFLOW Deleting files is a much needed and critical process. In RSE you can mark files for deletion on a folder by folder basis. Once you have marked all files that you want to delete for a certain folder you can revisit all these files in the "marked for deletion" tab (e.g. present them in a slide show - see below). To undelete a file just uncheck the deletion mark on the thumbnail pane. Once you are certain that you want to delete the files click on the waste basket icon and remove the images for good (they won't show up in your system waste basket).



3.1.3.3



IMPORTANT KEYBOARD SHORTCUTS •



TAB: toggle browser to image view



•



Ctrl: show overexposure indicator colors



•



Ctrl+TAB: toggle between zoom and fit size view



•



Alt+E: Auto exposure (good start)



3.1.4 IMAGE CORRECTIONS All the correction tools are on one "Correct" tab:



Correct tab All essential image corrections fall into the following categories: •



White Balance (WB)



•



Exposure and Tonality



•



Color tuning



•



Sharpness and detail



•



Noise handling



The "Correct" toolbar:



From left to right: •



Apply settings to other selected images



•



Activate WB gray balance tool (we just use shift+click instead)



•



Set WB to "as shot" in camera"



•



Auto WB and auto exposure. Auto exposure often provides a good starting point (Alt+E)



•



Back to initial settings



•



Forward to last active settings



Because we are here at some undo/redo feature it is a good place to show a very powerful RSE tool: Snapshots



Snapshots



You can create as many snap shots as you like and all these snapshot settings are stored for later use. Note: RSE stores all image settings in a sub folder with the name:



".RWSettings" and all settings files have the file name with the suffix "*.rws".



3.1.4.1



SETTING WHITE BALANCE (WB)



WB by Colder/Warmer



WB by color temperature White balance works as usual. The key correction methods are via color temperature or clicking on a light neutral gray object (don't use overexposed white areas). The color temperature is by default set to make the colors colder/warmer. You can change this method in the preferences to sliders using absolute color temperature. We actually like the default colder/warmer method because we think that WB is in most cases a very subjective decision. We found that "as shot" WB is often very good. We also like to photograph a gray card or Color Checker and use the gray balancing eye dropper. We are just missing some predefined and user WB presets. Note: The navigator pane will show how the image would look like if you would click the WB eye dropper at the current position.



3.1.4.2 EXPOSURE AND TONALITY



Besides WB that you need for good colors exposure and tonality controls are key to get a good photographic look in your images. RSE has different controls and we first had to learn hot to use them. Most raw converters support controls that are in principle a variant of levels and curves. Here RSE works differently. They actually operate adaptive (pixels are evaluated in their scene context, more like the Photoshop Shadow/Highlight tool). It seems actually more complicated to describe than to experience yourself. To get the best out of your image you have to find the best setting for all four sliders: •



Exposure compensation



•



Fill Light



•



Shadow contrast



•



Highlight contrast



Keep in mind that it is best to make use of all 4 sliders and to avoid the extremes. You should mainly do a visual correction but RSE also show supporting histograms (3 types, click to change the display type):



We like to use the version #1. On the top you also find three indicators for the highlights and shadows. They signal whether a certain channel is clipped. In our sample about the blue channel is clipped in the highlights. The best way to learn using the controls is to play with your own images. We have seen stunning improvements. The only attribute that we find to describe the results is: "more 3D like look" Here some first guidelines: Note: All values can be entered numerically. If you click the cursor in one



of the fields you can use the mouse scroll wheel for fine adjustments. Exposure compensation(EV): Is your image to bright then tone down the EV. If it is to dark try first Fill Light to brighten the image Fill Light: For most images it is a good idea to stay below a value of 50. Consider sometimes to lower EV and then to turn Fill Light up. Fill light will also help to open up your shadows. Shadow contrast: More likely to tune up to get more depth and contrast (punch). Highlight contrast: Here you can tone down aggressive highlights Again these four sliders work hand in hand. You should always work with all of them.



Sample 1



Dull overcast shot (Canon 1D Mk. II)



RSE settings



Result The Fill Light feature is a key tool for working on your images.



Sample 2



Typical shot with deep shadows (Canon 1Ds Mk. II)



Corrections



Corrected We spent before a lot of time getting the right tonality for this image (both in the raw converter and then masking in Photoshop). Took about 30 seconds in RSE (no kidding).



Sample 3



Overexposed Canon 1D Mk II shot



Corrections



Corrected We hope the corrected photo shows why we wanted to take the picture in the first place.



3.1.4.3



SATURATION AND HUE



Here you can do minor saturation and hue tweaking. We have both sliders most of the time set to zero. Note: The next tools sharpening and noise removal should be used at 100% or more magnification. That is why the sliders are grayed out at lower values (although they fully function). 3.1.4.4



SHARPNESS AND DETAIL



Hard to say how RSE reaches its level of very natural sharpness. Both top of the class debayering and normal sharpening are involved. Sharpening: We normally leave it to 0. Zero does not mean that RSE does not sharpen but this level is considered to get a very natural sharpness with low sharpening artifacts. We use RSE at this level 0 and the do final minor sharpening in EasyS. Detail extraction: This allows the user to set the RSE bias for fine detail or noise. The finer detail you want the more also fine noise will be undetected and vice versa.



Here is a sample comparison to our previous favorite for detail rendering Capture One:



Full 1Ds image 70-200mm f/2.8 lens, tripod, mirror lockup



100% magnification with C1 + strong EasyS sharpening



100% magnification with RSE + very light EasyS sharpening It is amazing how images look if they come directly from RSE with sharpening level at 0 (remember this does not mean there was no sharpening). Images have some sort of more 3D natural look.



3.1.4.5



NOISE REDUCTION



Actually removing noise is easy. We hear you yelling :-). But removing noise and keeping detail is the real challenge. Even more difficult is to also do noise removal in near real time. Honestly we have not played enough with RSE for a final judgment and also do not use that many high ISO shots. But RSE maybe the first raw converter that will be good enough for most of our photos without third party noise removal tools. The developer of RSE had to invest a lot of work into noise removal as the tonality feature allows to brighten shadows a lot. This operation is also pulling out the noise which is mostly in the shadows. Opening up shadows needs good noise removal. The two sliders deal with the two most common types of noise: •



Luminance noise



•



Shadow noise



We will use the noise removal too in our sample session below.



3.1.5 BATCH PROCESSING Once you have set all parameters you can add this image to the batch queue. The processing is then done in the background while you work on the next image.



At any time you can watch the batch queue and add, stop or remove batch jobs.



3.1.6 SAMPLE SESSION This is a sample shot and really of any artistic value:



1Ds at ISO 160 We find the shadows a bit too dark and used the RSE tonality sliders to open them up.



Opened shadows



But open shadows also means more noise:



200% magnification This called for some RSE noise reduction:



Reduced noise This sample was only intended to get you started with your own images. Don't overdo the noise reduction.



3.1.7 SLIDE SHOW There is also another nice feature: a slide show. The slide show is useful for two purposes: •



View your pictures



•



Set priorities and tag files for deletion



Slide show



Controls



Timing and transitions The slide show maybe the best way for an initial preview of your images. Note: Best you wait till all previews for that folder are generated as otherwise the slide show can be slow.
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4 USING PHOTOSHOP LAYERS



Camera: Nikon D1
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Layers are an essential tool for our workflow. This chapter gets you started with layers to make it your tool of choice. What are layers anyway? Think of multiple documents put on top of one another. If all layers were 100% opaque, then you would only see the content of the top layer. Even this would be useful as the layer hierarchy documents your steps used to refine the image. This means for our workflow that every image processing step is performed in a new layer. But there is much more to Photoshop layers ƒ



Layers can have opacity from 0% (transparent) to 100% (opaque)



ƒ



Layers allow different blending modes



Layers were invented for the use of graphic designers. This book only covers the elements that are most useful in your digital photography workflow. Layers are power tool that have some cost attached to them: ƒ



Layered documents use more space on your disks and in memory



ƒ



16 bit layers need even more memory and processor power



Photoshop CS is the first version of Photoshop that supports layers also in full 16 bit.
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4.1 UNDERSTANDING THE LAYERS PALETTE



Showing the Photoshop Layers palette Nearly all operations on layers can be accessed from the Layers palette. The layers are displayed from bottom to top (means that “Background” is the bottom most layer). First have a look at the all the different UI elements. This is a complex UI because Photoshop Layers are a real power tool. Again, learn as you go. The tools will look much easier to you once you use them in the context of your photographic workflow. The top most row shows the Blending Mode and Opacity for the currently selected layer. Both features are crucial for the layer based digital workflow.



Shows Blending mode ( “Normal”) and Opacity (100% the default) The tools in the next row are mainly used by graphic designers or painters. Can be ignored for most of our workflow.
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Layer tools that are used mainly by graphic designers and painters Every layer is either a normal Layer. Think of it as one full image on top of the other images. If you would then tune Opacity the layer below would start to shine through.



Normal layer Every layer has a name. Photoshop generates layer names for you but you should use your own names to document what your layers should do. You may even later replace this layer by a technically different layer that fulfills the same intention. Adjustment Layer: Adjustment layers are very important for our workflow. Adjustment layers are layers that are defined by image operations and not pixel content. We cover adjustment layers in more detail later.



Adjustment layer The left two columns show some icons that have the following meaning: indicates a visible layer. If you click on it the icon will disappear and this layer will not effect the final image. This feature can be very useful as it allows us to check the layer’s effect on the resulting image. It also allows you have multiple versions of processing in the same layered image. indicates that you can paint on this layer (you cannot paint on an Adjustment Layer) indicates that this is an Adjustment Layer and you cannot paint on it Shows the picture thumbnail for a normal layer. The thumbnail is the result of the current image at this level in the layer hierarchy. © 2002-4 Bettina and Uwe Steinmueller
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Indicates the operation used by an Adjustment Layer (here Levels) Indicates that Layer and Layer Mask are linked (we always leave it this way) Layer Mask for this layer (this is an optional property of any layer)



Layers Palette bottom toolbar



Layer toolbar Nearly all operations on layers can be accessed by using these buttons or the layer palette menu. Add a Layer Style (we have never used this) Add Layer Mask Create new Layer Set Add Adjustment Layer Create new Layer Delete Layer or Layer Mask Background images are treated special by Photoshop. They are not considered to be layers in the first place.



Background layer Note: All new images start without layers. This is why the Background image is not a layer. In most cases this is not an issue. However, some operations might not work on the Background image (read our section on “Smart Cropping”). You can leave the Background untouched most of the time. © 2002-4 Bettina and Uwe Steinmueller
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4.2 YOUR FIRST LAYER Let us revisit the sample crop with the dust spot.



Image shows a strong dust spot In the first take on dust removal the spot was removed directly on the Background image. There is a drawback in doing this. If you did not do a perfect job removing all the dust you later need to redo the complete image processing again by going back to our raw converter. A better approach is to perform the operation on a copied layer of the Background image. Drag the Background image in the Layer palette on top of the New Layer icon and drop it there.



Image with a dust spot Do not forget to rename the layer for better documentation. You now have a new layer with a copy of the Background iamge. Clean up the dust spot in just the same way as we described in chapter 2. If you make the new layer invisible, you can see that the dust spot is still there on the Background.
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4.2.1 CHANGING OPACITY New layers are created 100% opaque. But every layer can have a different opacity: ƒ



100%:



opaque



ƒ



0%: full transparent



ƒ



All other values: define an opacity between 0% and 100%



You will use opacity all the time. Especially it allows you to perform an operation in a way that it is initially too strong. You are then able to fine tune the effect by using opacity. Use the opacity slider for the last example and observe how the dust spot gets increasingly more visible the lower you dial the opacity value.
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4.2.2 UNDERSTAND BLENDING MODES In the last section, you saw how opacity works. Our workflow uses blending modes a lot. Blending Modes are also complex feature that is only covered as it is required by our workflow.



Blending mode selection Blending modes define the mathematics how pixels of the layer below and the current layer get “blended” (mean mixed) into a new value. Here are some blending modes that are used more often in our workflow. ƒ



Normal: Standard mode only the values of the current layer count (but the opacity controls the strength)



ƒ



Darken, Multiply: Used for burning effects



ƒ



Lighten, Screen: Used for dodging effects



ƒ



Overlay: A value of 50% gray does not effect the image. Values below 50% darken and above 50% brighten the resulting image.



ƒ



Soft and Hard Light: Can be used to increase saturation
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ƒ



Luminosity: Very important blending mode as it prevents unwanted color shifts (see our section on S-Curves revisited).



ƒ



Color: The layer will only change color and not any luminosity (most of the details)



ƒ



Saturation: The layer will only change saturation and not any luminosity or color hue



ƒ



Hue: The layer will only change color hue and not any luminosity or saturation
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4.3 FINE TUNING WITH ADJUSTMENT LAYERS Adjustment Layers are the major reason to use layers in our workflow. With Adjustment Layers, you do not put another image layer on top of your other layers. Instead, you perform image correction operations on top of the layers below. A new adjustment layer can be created using the button in the bottom tool bar of the Layer palette. There are many possible types of adjustment layers. For the photographic workflow most of the time the six marked in the below figure are used.



Shows the drop down list of Adjustment layer types You may find other options useful too once you found your personal workflow style. Now create your first Curves Adjustment Layer. As an example we darken the image using the following curve.
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Darken the image with a curves adjustment layer The Layer palette shows now a new Adjustment Layer.



Palette shows the new created Curves adjustment layer You might ask why this would be an improvement over using Curves directly on the original image? There is a big difference. Click on the icon of the new curves layer and the Curves dialog will pop up again. Now you can tweak your settings. This is not possible using curves directly on your image. Note: If you use Adjustment Layers, all your changes are not cast in stone and can later be modified. In addition, your settings are well documented. You can also inspect them at any time and can even save the Curves settings and apply them to other images. © 2002-4 Bettina and Uwe Steinmueller
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Once you have discovered Adjustment Layer you hardly want to live without them.



4.4 WORK SELECTIVE WITH LAYER MASKS Adjustment Layers would be useful as we described them. But Layer Masks add a completely new dimension. Layer Masks let you control how much the Adjustment Layer operation (here Curves) effect different areas of your image. We revisit the Fiery Furnace sample (again a small crop).



Shows the original picture Select the sky (using the Color Range tool)
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New Sky selected and create a Curves Adjustment Layer.



Layer palette shows the adjustment layer and the layer mask You have created a Curves Adjustment Layer with a Layer Mask. Note: If you Alt+click on the Layer Mask icon, Photoshop will display the Layer Mask instead of the image (Alt+Click brings back the original view).
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Layer Mask as grayscale image Note: You can see that Color Range did not really produce a perfect mask. Creating masks for objects like this can be tricky. Our workflow does rarely rely on perfect masks as they are an art by itself. The books by Martin Evening and Katrin Eismann cover this subject in more detail. You should try to avoid complex masks as much as possible. 4.4.1 UNDERSTANDING LAYER MASKS A Layer Mask is actually an 8 bit grayscale image. White means that the Layer or the Adjustment Layer operation (e.g. Curves) will be 100% effective at that position. Black means the Layer or Adjustment Layer operation will be 0% effective. The real importance comes with gray values. X% gray means the effect will be effective by X%. This is exactly like controlling the opacity on a pixel-by-pixel basis. Black-to-white gradients allow you to get smooth transitions if needed. This concept is even more powerful. You can even paint using brushes on the Layer Mask and control its behavior.



4.5 FLATTEN IMAGES AND MERGING LAYERS 4.5.1 FLATTEN IMAGE Sometimes you want to get rid of the layer structure because you need to save the file as a JPG or non-layered TIFF. © 2002-4 Bettina and Uwe Steinmueller
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This is very easy; just select the Flatten Image menu command and you have a simple non layered Background image. 4.5.2 MERGING LAYERS Even more often you need to perform an operation (e.g. sharpening) on the combined result of the underlying layers. Flattening is not a real option as you do not want to lose the layer structure. 1. Create a new empty layer on top of all the other layers (this layer is filled with transparent pixels):



Create a new empty layer on top 2. Select Merge Visible, do not release the mouse button yet, hit the Alt key and then release the mouse button.
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Layer palette menu As the result there is a new layer filled with the merged result of all visible layers.



Combined layer on top Now you can perform you filter operation of your choice on this new layer. Note: If the new layer is 100% opaque and you change any underlying layers it will not effect the final image. This means if you want to tune Adjustment Layers below this layer you have to recreate this combined layer and also perform the operation(s) again. That is why a good naming is so important. It will remind you what this layer should do. © 2002-4 Bettina and Uwe Steinmueller
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4.6 APPLY ACTIONS AND FILTERS IN NEW LAYERS Many actions and some plug-in filters are not designed to be used in layers. Some experts may say that the solution is very simple: 1.



Duplicate image



2.



Flatten image (in case it has layers)



3.



Perform action/filter on this image



4.



Select all (Ctrl+A)



5.



Copy the result



6.



Close the duplicate file



7.



Create a new layer on top of the original image



8.



Paste the processed image into the new layer



This is a tedious manual task and should be implemented by an action itself. You actually need two actions: ƒ



Preparation



ƒ



Post processing



Since the action is general it does not know anything about the actions or filters used by the users. Here are the actions that do the trick:
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Steps that are performed by the MakeALayer actions If you want to use these actions inside your own actions. Simply record a new action like: ƒ



Run "MakeALayer_Pre"



ƒ



Run any action or filter



ƒ



Run “MakeAlayer_Post”



There is one more advantage to the layer approach. You can for example use a slightly stronger sharpening filter and tone down the effect by changing the layer's opacity. There are the usual downsides to this layer approach: ƒ



Layered files need a lot of disk space



ƒ



Need more memory



It makes also sense to rename the new layer. That way it can document what operation was done in that layer. Click on the small square in the second left column for the "Make layer" entry. The "Make layer" dialog will prompt you for a new name.
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4.7 SMART CROPPING This photo below made us ask the question: What if we could crop it and also keep the full image to change the crop later?



Dunes in Death Valley shown before any cropping Looking at this photo (as shot, no crop) it is not very obvious what would be the best possible crop or even if cropping would be even necessary. After cropping the image you would then spend time on contrast, shadows, colors, retouching and saturation. These are done by layers on top of the crop. You may also do one to four proof prints during this process to find out the best way to print the photo. You hardly would want to redo all these changes from scratch if you decide on a different crop in the future. Katrin Eismann (author of "Photoshop Restoration & Retouching") showed us a solution to this problem. This technique is based on using Photoshop’s Crop tool. 4.7.1 USING THE CROP TOOL This is by no means a tutorial about the Crop Tool. We cover only aspects that help us to solve the problem. For our exercise we will use a file that has no layers (only the Background image).
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If you select the Crop tool you get the following tool palette:



Crop tool options You then select the area you want to crop:



Crop tool hides the parts that will be cropped off The area that is not selected displays darkened. You can change and move the selection as you like. The Crop Tool palette changes to:



Changed Crop tool options If you then hit enter the photo gets cropped without being able to get the full image back later once you saved the file. There is feature “Hide” that
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cannot be selected on this image because “Hide” is not available on the Background image. Why? Because the Backgroung image is not a layer.



Background image is not a layer Fortunately we can change the Background into a layer. Just double click on the "Background" and confirm the new layer dialog



Making the Background a layer This transforms Background into a layer with the default name "Layer 0"



The background image has become a layer If you now use the Crop tool again the crop tool bar has changed and you can select the “Hide” option.
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Options allow selecting “hide” You can now choose between a "Delete" and "Hide" for the area that gets cropped. Delete is what happened before, so that is why you use "Hide". If you hit "enter" the image looks the same as if the cropped areas had been deleted.



Shows the final cropped Image (cropped areas hidden) Where is the original image? With “Image->Reveal All” we get back to the original full sized image.
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Reveal hidden image areas



The original image is revealed to the original full size So far, this is a nice solution. But you may want to restrict the aspect ratio to 3:2 (like you can do with the rectangular Marquee tool). It was not obvious how to solve this as there is nothing in the tool palette that mentioned aspect ratio. Here is a solution from Martin Evening (author of "Photoshop 7 for Photographers"):
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Select width and height to constrain proportions Enter width "3 cm" and height "2cm" and leave resolution open. Now the Crop tool keeps a 3:2 aspect ratio. The only odd thing is that it will set the resolution value to some funny value to keep the crop 3cm x 2cm. This can easily be fixed using the Image->Size dialog. If you crop often using the aspect ratio 3:2 then it is easier if you save the setting as a preset for the Crop tool:



Setting crop tool presets You can recall the 3:2 setting later at any time.
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4.8 MINIMIZE S-CURVE SIDE EFFECTS Improving contrast by using S-Curves is a standard technique to improve contrast. Often these S-Curves also improve saturation. But what if you want to improved contrast and avoid shifted colors?



This is our flat looking original image Instead of using S-Curves directly you create a curve adjustment layer. Curves Adjustment layers are integral part of the general workflow.



Enhance the contrast with a weak S-Curve © 2002-4 Bettina and Uwe Steinmueller
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Contrast is now enhanced by S-Curve (with slight color shifts) While enhancing the contrast, you also get a color shift that you may not want in this case. You can avoid the color shift by changing the blending mode of the adjustment layer from "Normal" to "Luminosity".



Changing Blending Mode to "Luminosity"
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Blending Mode was changed to "Luminosity"



Note: The subtle changes are hard to see on small images or on the web. It is best if you try this yourself with an image that needs some contrast boost. There is actually an interesting complementary variation to this technique. If you use “Color” as blending mode the contrast only changes the colors and does not increase the luminosity contrast.
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4.9 HOW TO REMOVE MOIRÉS Some cameras produce some color aliasing (small colored pixels in the photo). You can remove moirés using the following method.



Sample shows moiré from a Fuji S2 (at 100% pixel level) 1.



Create a new merged layer



2.



Use the Dust & Scratches filter (radius 3-7 are good values)



Using the Dust & Scratches filter © 2002-4 Bettina and Uwe Steinmueller
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Now the image looks all blurred (no problem though) 3.



Set the layer’s blending mode to “Color” and all is fine.



Set layer to Blending Mode “color”



Moiré reduced You can even use a stronger filter and tone done the effect using opacity.
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4.10 USE AUTO COLORS TO TUNE CONTRAST Normally, you should be very careful with every tool that has the name “auto” in it. Your eyes and skills are soon better than most automatic tools. However, as with every "rule", there are exceptions. Here is a trick that uses auto colors in Levels to tune contrast. You start with an unsharpened image (this is actually a small crop)



Sample image has a flat contrast (100% pixel crop) 1. Create a new Levels Adjustment layer and you get this histogram in Levels
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Opening Levels Dialog for the Adjustment Layer



2.



Click on Options



Selecting the Auto Color settings 3.



Change the settings to ƒ



Enhance per Channel Contrast



ƒ



Set both Clip values to 0.2. The default 0.5 seems to strong for us, but you should experiment to see what suits your taste best.
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Actually remember that clipping is bad most of the time. But with this technique you get away with it. ƒ



You can also check “Save as Default” if you want 0.2 to be your future default.



Don’t worry about the horrible colors you see right now. Here is what happens behind the scenes. Each channel is clipped in the shadows and highlights by 0.2%. Because each channel gets clipped differently, the result can be a very strong color shift. The next figure shows only the red channel, but you should inspect green and blue as well.



Clipping in color channels (here red) 4.



The photo looks now this bad
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The image suffers from major color shifts Lesson: Auto Color can get horrible results. However, don’t worry, we are still on track. 5.



Change the Blending Mode of this layer to “Luminosity”



Voila, the colors are back. The Luminosity Blending Mode for a layer ensures that only the contrast on detail is changed and not the colors.



Blending mode set to “Luminosity”
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Contrast overdone 6.



Tune down opacity to about 30%



The contrast has been increased. Unfortunately, this is far too much due to the strong clipping. What do we do if a layer shows the right effect but just too much? Correct, we turn down the opacity. In this case, about 30% opacity will do the trick.
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Contrast improved with lower Opacity 7.



With some final sharpening, you can gain also better local contrast.



Showing the final image after sharpening
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4.11 OPTIMIZE LAYERS WITH ADVANCED BLENDING OPTIONS If you select the Blending Options for a layer the following dialog will pop up.



Showing the Advanced Blending default setings The slider labeled “This Layer” allows a very interesting control of the blending. For example in the last section you learned hot to improved the contrast. The downside of this technique can be too much contrast in the highlights and shadows. You can reduce the effect to the highlights and shadows if you set the sliders as shown here
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Showing the new Advanced Blending settings To separate each of the small triangle pairs you use the Alt key while dragging one of the triangles. What do these settings mean? Between the right most black triangle (here 22) and the left most gray triangle (here 204) the layer effect will be 100%. Between the black and the gray triangles, the effect fades from 100% to 0%. This way you get a smooth transition.
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4.12 DODGE AND BURN USING LAYERS This is a concept Mac Holbert showed us when we visited Nash Editions in January 2003.



We want to brighten up the bird’s body 1.



Create a new layer



Create a new layer with Overlay Blending mode 2.



Set Mode to Overlay and select layer is filled with 50% gray.



Overlay is a very special blending mode with the following properties (for more details consult the Photoshop help) ƒ



50% gray leaves the image unchanged (that is why we start there)
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3.



ƒ



Painting with values below 50% gray will darken the image (black is strongest)



ƒ



Painting with values above 50% gray will lighten up the image Select the Dodge Tool



Select Photoshop Dodge and Burn tools 4. Set the exposure to 5-15%. enable the Airbrush option and use a reasonably large soft brush. If you now paint on areas that are too dark for your taste they will brighten up the more you paint in that area. The lower the exposure the more you need to paint but also have so much more control.



Select your dodge options 4.



Doge the birds head and body with a few careful brush strokes.



If you make all other layers invisible you can see how your dodge & burn layer looks like.
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Shows only the Dodge & Burn layer The dark areas show the areas used to burn (no burning here) and the bright ones are used for dodging. The following picture (blending of the original picture and the Dodge & Burn layer) illustrates our point Here is our resulting image:
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Avocet has improved brightened shadow
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Managing The RAW File Workflow



CHAPTER



5



5 BASIC DIGITAL WORKFLOW



Camera: Olympus E-1
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This chapter is the core of our workflow book. It is not a long chapter as we will exploit the techniques laid out in previous chapters.



5.1 PRE RAW CONVERSION STEPS 5.1.1 CAPTURING PHOTOS IN THE FIELD



We will cover only a few aspects that you should consider to make your work easier in the digital darkroom part of the workflow. © 2002-4 Bettina and Uwe Steinmueller



210



•



Check your exposure with your histogram



Watch your camera histogram * Make preparations to correct white balance. A good way is to photograph a digital gray card or even better a GretagMacbeth ColorChecker.



GretagMacbeth Mini ColorChecker •



Avoid high contrast or make multiple images for blending.



•



Avoid high ISO if possible



•



Use a tripod as often as possible



•



Prepare multiple images if you plan to stitch images (see chapter 6) for higher resolution of panoramic photos



5.1.2 TRANSFER IMAGES TO YOU COMPUTER © 2002-4 Bettina and Uwe Steinmueller
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We copy the full raw file folders from the Microdrive (CF card) to our computer using a USB 2.0 or Firewire compact flash card reader. When finished copying the Microdrives to the disk, we give the new folders a new name, which also includes the date (see chapter 1 for our file organization).



Rename Files This is also the right time to rename your raw files (see chapter 1).



5.1.3 BACKUP YOUR IMAGES



Consider for a moment the following, you have just formatted your Microdrive and at the same time your computer hard disk breaks. Then all your photos would have been gone! If you keep a backup on a different physical disk all the time, there is a much lower chance that both disks break at the same time. We use a PC tool automatically mirror the data from one disc to a backup disk. 5.1.4 PREVIEW IMAGES
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Browsing your captured images in Photoshop CS Reviewing your images is an essential phase in your workflow. Every image you miss might be lost forever and each image you work on for some time that does not have the quality you need is wasted time.



Select the Keepers All the next steps are only performed for the images you find have the quality and content you want.



© 2002-4 Bettina and Uwe Steinmueller



213



5.2 RAW CONVERSION PHASE (NOT FOR JPEGS)



If you work with JPEG files you can skip this section as your camera has already processed the internal raw data. Now we work on the keeper RAW files one at a time (batch conversion only works if you have many photos with exactly the same characteristics). We assume you understand your raw converter now. Otherwise please revisit chapters 3 first. •



Load a raw file into Camera Raw 2.0, C1 or Nikon Capture



•



Correct your WB



•



Check the image/histogram and use EV correction if necessary



•



We do not sharpen in ACR 2.0, C1 or Nikon Capture (some initial sharpening can be useful though if you want to use the two phase sharpening technique)
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5.3 PROCESSING AFTER THE RAW CONVERSION



5.3.1 REMOVING NOISE



Strong ISO and shadow noise This might be the place to remove noise. We try to avoid noise removal, as there are always side effects that change detail and/or colors. We expect better tools in the future. The best (yet complex) tools seem to be Neat Image and Noise Ninja (unfortunately both are only PC tools). ACR 2.0 and C1 do quite a good job in noise removal for low ISO images.
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5.3.2 REMOVE MOIRÉ OR ALIASING ARTIFACTS For the some images, we run sometimes our moiré eraser action here. Have a look at 100% pixels, look for single colored pixels, and judge whether this might be distracting. 5.3.3 CROP NOW, IF YOU NEED TO SAVE SOME TIME Now you can crop your photo. This makes sense if you make a major crop now as this could save you some processing time for the next steps.
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5.4 IMPROVING AND RETOUCHING USING PHOTOSHOP LAYERS From now on, we work only in Photoshop Layers. 5.4.1 IMPROVE LEVELS The first step for us is to check levels and if needed to correct them in a new adjustment layer.



Check and Improve Levels Don’t just correct for the histogram. Look what happens to your image and do not create too much contrast. You can do also your levels in C1, ACR 2 or Nikon Capture. We like the images slightly soft out of the raw converter to have more latitude for subtle contrast improvements. 5.4.2 REMOVE COLORCAST (WB) If the WB correction in the RAW converter does not satisfy you, this is the place to improve the WB. We get pretty close most of the time with our raw converters. If you use JPEGs this is a very crucial step even if some cameras have very good auto white balance capabilities. For colorcast removal, you can use one of the following methods: © 2002-4 Bettina and Uwe Steinmueller
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•



iCorrect EditLab



•



Photoshop CS Photo Filters



•



Photokit Warming/Cooling



•



Photoshop curves



5.4.3 IMPROVE EXPOSURE WITH THE PHOTOSHOP CS SHADOW/HIGHLIGHT TOOL We featured Shadow/Highlight in our chapter 2. 5.4.4 RECOVERING SHADOW DETAIL Digital files from modern digital SLRs can hold a lot of detail in the shadows if you use low ISO settings. Fred Miranda created very sophisticated SR (Shadow Recovery) actions to make your life easier. You can select from five levels (very low, low, medium, high, and very high). We often play with his “very low” to “medium” settings as the higher settings can easily show too much noise because the shadows hold also most of the noise. Before you use any shadow recovery actions or plug-ins try to use the “Film extra Shadow” tone curve in Capture One DSLR. 5.4.5 IMPROVE CONTRAST USING S-CURVES IN A CURVES ADJUSTMENT LAYER We discussed the S-Curves in the Photoshop section. The following screen captures demonstrate how small changes in the S-Curve show up in the resulting photo.



© 2002-4 Bettina and Uwe Steinmueller



218



S-Curve Changes
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5.4.6 CORRECTING BRIGHTNESS WITH CURVES



Brightness Lighter



Brightness Darker
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Managing The RAW File Workflow



5.4.7 IMPROVE SATURATION Most often proper contrast will take care of missing saturation. If you want to enhance the global saturation then the saturation actions by Fred Miranda perform a good job. Most saturation tools (including the one in Photoshop) have the side effect of shifting colors. You can also improve saturation in ACR and C1. 5.4.8 SELECTIVE COLOR CORRECTIONS Clearly, for selective color correction Color Mechanic Pro is our tool of choice although we only need to perform selective color corrections with about 5% of our photos. However, if we need this is just the right tool.



Color Mechanic Pro We use Color Mechanics Pro on a merged extra layer.
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Managing The RAW File Workflow



5.4.9 RETOUCHING AND REMOVING DUST SPOTS Sometimes the camera sensors collect dust. These spots are easy to see in brighter parts (e.g. sky) of the image. Here you can use the Photoshop clone tool to copy over the spot with a similar area of the image. Photoshop 7.0 introduced a very sophisticated clone tool: the "Healing Brush". The healing brush melts the source and target areas together and gives a more pleasing result. This tool alone makes the upgrade from Photoshop 6.0 to 7.0 worth the expense.



Healing Brush – Before And After The above images are 100% pixel crops from a real life example (original was 3000 x 2000 pixels). Before and after images above those show the use of the Healing Brush. In addition, the clone tool easily removes these spots but there are many situations where the "Healing Brush" is easier to use and provides better results. We rarely use the clone tool to remove unwanted parts from the photo. Use the Healing Brush on a merged extra layer. 5.4.10 PERSPECTIVE CORRECTION
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Perspective Correction Photoshop allows you to correct the perspective. Although this is a powerful tool in Photoshop, it is far better to get it right in the field in the first place (e.g. using a shift lens). We also have sometimes photos off level (Uwe more often than Bettina). We correct these faults by using the transformation command “Rotate”.



Edit->Transform->Rotate
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Some lenses show more or less severe barrel or pincushion distortions. Here is a list of some good tools: •



PowerRetouche Lens Corrector: Does a nice job



•



ImageAlign: Very powerful lens and perspective correction plug-in. It is expensive though.



5.4.12 SHARPENING Now you can sharpen you photo. Use the sharpening method of your choice (see our section on sharpening). If you intend to upsize your photo, you might want to defer the sharpening till after the final upsizing step. 5.4.13 SAVE THE RESULT AS A LAYERED 16BIT MASTER PSD OR TIFF We now save the result as a master file. We use the Photoshop PSD or TIFF format. If you are working on a masterpiece, you probably will repeat the whole workflow several times. If you think, you have done your best then this master file should be stored and a backup kept in a safe place. 5.4.14 PRINTING & PUBLISHING Printing is covered in some more detail in chapter 8. 5.4.15 ARCHIVING Archiving will be briefly covered in chapter 10.
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CHAPTER



6



6 ADVANCED PHOTOSHOP WORKFLOW TECHNIQUES



Camera: Sony F828
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6.1 SELECTIVE SATURATION IMPROVEMENTS Often we have the impression that digital photos might need some improved saturation and actions and filters that can do this are pretty popular. Let me start with some general comments: There is a tendency (Introduced by films like Velvia) to have too much saturation in our photos (bigger than life) and lose some subtle natural colors. If you put two photos side by side that only differ in saturation the one with more saturation will draw more of your attention. Does it mean it is better, most often not. Before you even look into enhancing your saturation get the contrast right first. Some S-Curves might do the trick. But then again there are times you want (need) a bit more saturation. But whenever I used tools to increase the global saturation I was less than pleased. But then an article by Ben Willmore in the Photoshop User magazine changed my whole world. The article is called "Saturate your World". We were a long time admire of his articles in the "PEI" magazine and now of his series in the Photoshop User magazine (magazine of the NAPP - National Association of Photoshop Professionals). Whenever you come across an article by Ben, read it. Also his excellent book about Photoshop 7.0 is part of our library (See Adendum). First his message sounds nearly obvious: Use selective saturation in Photoshop. Why did we not do this before? It seemed to be complicated. It actually is if you try it on your own without Ben's guidance. But Ben gives a wonderful practical tutorial how to master selective saturation enhancement. We now believe that global saturation enhancement is wrong most of the time. We go even one step further and apply selective saturation enhancement for selective areas of our photos. Here is an example
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Grand Canyon: Mather Point Actually, we want to enhance the saturation in the top part of the photo and keep the bottom as is. We create an adjustment layer (in 8 bit mode) using Hue/Saturation. Then we change the layer mask for the layer to something like this



The black part prevents the saturation to change at the bottom with a soft transition to white.
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You then open the Hue/Saturation dialog and do not touch the "Master" settings. We change the reds using the "Red" settings.



We do not want to repeat anything what Ben wrote so please figure out what the different sliders mean.



© 2002-4 Bettina and Uwe Steinmueller



228



Here is the result of this operation. We now thought it might be a bit too strong and could have changed the saturation settings. Instead, we modified the opacity of this adjustment layer.



And here we are with our final version:
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The differences are subtle but that is actually what selective saturation is all about. Think selective!
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6.2 MORE SATURATION AND CONTRAST TRICKS As all photographers know there is rarely something like the "right light". Especially for our recent work called "Earth Frames" there are the following choices: •



Mid-Day sunlight with harsh shadows and burned out highlights



•



Evening sun with better light but long shadows



•



Overcast with flat light



From these alternatives, we favor the "overcast". Best would be a very light overcast so that the light is like an optimal light box.



Flat image to start with



We will most likely get some flat images right from the raw converter. Yes, we could tweak it in the raw converter but prefer to do this work with layers in Photoshop That way we can revisit all our changes and improve them later. The first step is most often an adjustment layer using "Levels"
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Levels Adjustment Layer As you can see we did not move the white point that much as the photo would get too bright and also does not contain real white details.



After Levels Now we increase the contrast using some S-Curve in a Curves adjustment layer.
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S-Curve



After Curves
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S-Curves tend to create a slight color shift that can be removed by changing the blending mode of the layer to "Luminosity" (the change is subtle and best you try everything yourself).



Changing blending mode to luminosity



After change to "Luminosity" There is still the desire to increase saturation and micro contrast. There are many ways to go. We want to explore a technique outlined to us by Katrin Eismann (author of "Photoshop Restoration & Retouching"). Using an adjustment layer with "Hard Light" blending mode



© 2002-4 Bettina and Uwe Steinmueller



234



Create a new Curves adjustment layer and change blending mode to "Hard Light".



100% "Hard Light" Kind of obvious that this is not what you want, right? Don't worry, the right selection of the layer opacity allows us to tone the effect down to a more pleasing level.
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Changing the Opacity



Hard Light at 27% There can be a problem using this technique; the shadows might get to dense. As we use a Curves adjustment layer we could use curves to control the impact on the shadows. But there is a more elegant solution. Open the layer's blending options and move the left slider for the "Underlying Layer" to the right. Now below 46 the values are not affected anymore.
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Setting the "Blending Options" This is still not what we want as the transition would be visible. But there is more. If you look carefully you see that the tiny triangle sliders are split. You can separate them by using the ALT key and moving the right part of of the triangle to the right. Voilà:
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Now all shadows below 52 are protected from our "Hard Light" layer, then there is a smooth transition zone up to 85 and finally the layer effect is fully visible above 85.



Variation with "Soft Light" You can do the same using the "Soft Light" blending mode. This time the effect is less dramatic.



Soft Light at 100% opacity



© 2002-4 Bettina and Uwe Steinmueller



238



Soft Light at 27% opacity Be careful that your photos don't get too punchy. Also photos directly contrasted with strong saturation photos look even flatter than they are. This is one reason that natural saturated photos are received as flat because we are bombarded with to many over saturated photos today (the heavy metal of photography).
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6.3 DIGITAL PERSPECTIVE CORRECTIONS If you photograph building with 35mm cameras and normal lenses (not tilt/shift) the buildings will be shown tilted. Part 1: Simple Perspective correction



On the left is the original and on the right the corrected version This correction is very easy in Photoshop. First prepare your image as you would usually (I even sharpen before but this might be less than optimal). The next screen shot illustrates what to do in Photoshop
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The steps: •



Resize the viewing pane so that you have plenty of gray space surrounding it



•



Select all (CTRL+'A')



•



Menu: Edit->Transform->Perspective



•



Drag the upper left handle and move it to the left until the image looks good for you (this photo was intentionally a bit under corrected)



•



Photoshop renders a preview pretty fast. Don't be afraid of the quality the final rendering will do much better



•



Once the photo is ok hit "Enter" and Photoshop does the final rendering



•



Deselect the image (CTRL + 'D')
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6.4 REFINED PERSPECTIVE CORRECTION



Before and after Again prepare your image as you would usually and perform steps 1-6 as above. You get the following result (do not hit "Enter" yet).
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But this time it needs extra correction on the right side of the photo. •



Menu: Edit->Transform->Skew



•



Drag the upper right handle to the right to get the right part better in parallel



•



Drag the upper right handle now up that you get the top better aligned



Note: Some Photoshop plug-ins seam to make these corrections easier but they are usually quite expensive.
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After step 9 we your screen looks like the above screen shot •



Hit "Enter" and Photoshop does the final rendering



•



Deselect



•



Crop the photo



This simple procedure helps you to enhance many of your architectural shots. Here is an other sample
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The above photograph is taken from an outdoor poster at the Hundertwasser house in Vienna. The result (on the right) was created using the technique described in this section (skew and crop).



© 2002-4 Bettina and Uwe Steinmueller



245



6.5 CORRECT YOUR LENS DISTORTIONS Some lenses show especially in the wide angle range some distortions, mainly pincushion or barrel.



Out tool of choice in such a case is PowerRetouche Lens Corrector.
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We used a barrel correction of –8 and some cropping. Here is the result



As with all correction tools we never try to be too perfect. We correct problems only if they get too much of the viewers attention.
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6.6 HANDLE BLUE SHADOW CASTS Shadows often have a strong blue cast and this can look even stronger when you print these photos. Why is the cast blue? For most outdoor photos you have to take two light sources into account: •



Direct sunlight



•



Blue sky



The shadows are not illuminated by the sun but by the blue sky, thus the blue shadow cast. 6.6.1.1 IN PHOTOSHOP Here is a crop from a photo with some blue shadow cast



Create a new Hue/Saturation layer and this dialog pops up
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Select from the edit drop down box ”Blues” and click with the eyedropper into the shadow. Now we check the area that is influenced by this color range by setting the saturation to 100.



The preview confirms that exactly the shadows are affected by this selection. If not you can tweak the range using the color sliders.



To remove the blue shadow cast and also brighten the shadows a bit we actually reduce the saturation and enhance the brightness for this color range. Here is our final crop:
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6.6.1.2 WITH COLOR MECHANIC PRO For selective color corrections, Color Mechanic Pro (see our tools section) is our tool of choice. Color Mechanic is now also our best tool to remove blue shadow casts. Here is how we work.
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Pictographs at the Grand Canyon Desert View Watchtower This photo has a clear unpleasant blue shadow cast. We use Color Mechanic in 16bit mode to handle this problem.



Color Mechanic before/after view
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We click into the blue shadow and correct the cast with the following setting inside the color cube.
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Now our photo is much better but has now still some magenta cast.
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Removing the magenta cast With these two little steps, we get the final improved photo.



Final version Here is a different example from our Grand Canyon series.
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Blue Shadow cast removal Using this technique the shadows get much more transparent. On the other side, you lose a bit of contrast and here some of our S-Curves help.
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6.7 USING LUMINOSITY MASKS We learned about this feature from Katrin Eismann and find the luminosity mask important to know. As you learned any mask is actually a grayscale image and a luminosity mask is nothing else then a mask made from the grayscale image of the color image at hand. Creating a luminosity mask is very easy: •



In the channels palette use “Load channel as Selection” while in RGB mode



Load channel as selection •



Save the selection and you have an luminosity alpha channel



Now you have a mask that has transition from the highlights to the shadows (highlights will be bright and shadows dark). This means if you would use this mask as a layer mask all operation would be stronger on highlights than on the shadows. If you want the inverse then just load the selection, invert it and save it again. 6.7.1 SAMPLE SESSION WITH LUMINOSITY MASK © 2002-4 Bettina and Uwe Steinmueller
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Original image We want to tone down the highlights and open a bit the shadows (a very common task) •



Create a luminosity mask



•



Save the mask



•



Load the selection from the mask



•



Create a curves adjustment layer
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Curves to darken the highlights



•



Change the Advance Blending to restrict changes to the upper midtones and highlights.



© 2002-4 Bettina and Uwe Steinmueller



258



Advanced Blending



With toned down highlights Now we open up the shadows: •



Load selection from luminosity mask



•



Select->Inverse



•



Create a new curves adjustment layer
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Curve to brighten the shadows



•



Change the Advance Blending to restrict changes to the lower midtones and shadows.
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Advanced Blending Here is the final image:



Final image Note: Do not forget that you can tone down the effects by using opacity.
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6.8 CONTRAST MASKING There are many photos where one would like to darken the highlights and get more shadow detail. "Contrast Masking" is a well known technique in the physical darkroom to do just that. Of course in the digital darkroom Photoshop is the tool of choice.



This was the original file as we got it directly from Nikon Capture 2. Ok it was a hazy day but still the sky has to little color, the trees are too dark and also the cliff plateau. Here are the first initial steps Select the layers palette and perform "Duplicate Layer" Set the blending mode to "Overlay" Select the newly created duplicate layer and do "Image->Adjust>Desaturate" (this layer is now an grayscale image) Then create a negative from this layer by using "Image->Adjust->Invert". Don't bother that the result looks pretty strange. © 2002-4 Bettina and Uwe Steinmueller
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Now set the "Opacity" to about 80% (you can fine-tune this later).



And last not least use "Filter->Blur->Gaussian Blur" to blur the negative layer. You can then control the effect by choosing a radius between 20-100. Most of the operations are quite fix but the two parameters "Opacity" and "Radius" are crucial to your success and you have to experiment to find the optimum for each photo. In our case we ended with 80% opacity and a radius of about 96.
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For me "Contrast Masking" is from now on part of my usual tool box. Variation Initially the article was finished here. But then I tried an other photo and came up with some nice improvement.



Even with curves this photo seems just too dark. If we apply the above technique we get the following result.
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Some improvement but still too dark in the cliff. The solution is an extra curves adjustment layer Add an adjustment layer with "Curves"



Now we get this final result.
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There are probably many other useful variations. Note: In our own work we use the contrast masking that is part of the PhotoKit toolkit (see our chapter on “Useful Photoshop Tools”).
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6.9 REFINE YOUR IMAGE WITH PAINTING TECHNIQUES 6.9.1 PAINTING USING LAYER MASKS



In this example, the eye and part of the head of the Avocet chick are in the shadow. We would like to brighten it up. We create a Curves Adjustment layer and brighten the whole image
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The resulting image is clearly too bright. Don’t worry.



Use the Paint Bucket and fill the Layer Mask with black:
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The black layer mask hides all the brightening effect of this layer. We use a soft big brush •



Color White



•



Opacity 15%



and paint a few strokes over the face. By using the 15% opacity you have a lot of control to brighten the face (try higher opacity to experience it yourself).



A look at the Layer Mask (Alt-click on Layer Mask thumbnail) reveals the secret.
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This is a universal technique for selective image enhancement and can be used with many different types of layers: •



Layer with a sharpened version of the image



•



Layer with a noise removed version of the image



•



Hue/Saturation Adjustment Layers



•



Curves Adjustment Layer using S-Curves
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6.10 GAIN HIGHER RESOLUTION THROUGH STITCHING There are many reasons that stitching photos to make a larger new photo is very attractive: •



Panoramic views



•



Gaining resolution



Of course, there are also many hurdles for a perfect stitch •



Moving object



•



Image transitions



•



Different angle of view



•



Lens distortions



We ourselves only use stitching to get a moderate panoramic view from 35mm digital SLRs. To avoid most of the problems we do the following: Only use shift lenses (e.g. Canon 24, 45, 90 T/S, Nikon 28,35,85PC) and take only 3 photos (shifted right, middle and left). There are still parallax errors as the lens moves and not the camera body. For nature photos these parallax errors hardly show and even in architecture you have to be very picky to find faults in prints. If you want to get more into stitching, have a look at Panorama Tools (it is even free).
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6.11 STITCHING IN PHOTOSHOP CS The technique shown here was developed by our friend Jim Collum. For panoramic views the camera is used in horizontal mode and for 4:3 high resolution images in vertical mode.



Two be able to switch the camera fast from horizontal to vertical you should use a so called L-Bracket. These L-Brackets work with tripod heads that support the Arca Swiss standard. All our cameras and long lenses are equipped with custom plates for Arca Swiss clamps. First you have to make three exposures in the field. Set the exposure to manual (we actually do that all the time) and ensure that all three photos use the same settings: •



F-stop



•



Exposure time



•



Same focus



•



Camera does not move (of course there are micro movements to the tripod shifting the lens and taking three exposures)



Take the photos: 1. Shifted to the right © 2002-4 Bettina and Uwe Steinmueller
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2. Shifted to middle 3. Shifted to the left If you use a raw converter ensure that all three pictures are using all(!) the exact same conversion settings. Once you have the converted images (or your JPEGs) you can start stitching in Photoshop. All images have to be 8 bit. 1. Select the three images in the Photoshop CS file browser



Select the three converted images in PS File Browser 2. Select Photomerge from the File Browser menu
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4. the following screen will show



5. important is to select the “Keep as Layers” option



Use Options as shown Your screen show now the stitched image. But all three parts are in its own layer.
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Original layer structure 6. Move the middle layer (also middle part of the image) to the top (drag & drop)



Middle part as top layer Although Photoshop does a nice job for an initial image alignment you will do now a finer tweeking. 7. Set the opacity of all three layers to 50%
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Stitched image with all layers to 50% 8. select the layer with the left most part of the image (here layer 2), hide the right part of the image and also view the image at 100%



Some misalignment 9. Select the move tool and use the arrow keys to move the left part of the image into alignment. The result will look like this:



© 2002-4 Bettina and Uwe Steinmueller



276



10. Select now the right part of the image and hide the left part. Use again the arrow keys to bring the right part into better alignment. 11. You now create the seams by erasing the left and right parts of the top layer (the middle part). You want to create a seam that is not visible. You can set the opacity of the top layer now to 100%. Use the eraser tool with a soft brush at about 150 pixels and erase the seam area on both sides.



Erase the seam area
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This is the core to Jim’s technique as you can control that you seam can work around e.g. moving branches (they can be completely in one of the three parts of the image). 12. Hide the left and right images and fully remove the areas left of the left seam and right of the right seam.



Seam areas fully removed 13. Set all layer to visible and 100% opacity 14. Perform your final crop



Final Image 15. The stitching is done. You can either flatten the layers or keep them. 16. Now you treat this image like any other image and correct exposure, contrast, colors and sharpen. 17. (optional) or convert it to B&W
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6.12 ADVANCED SHARPENING WITH LAYERS We always perform sharpening in a new layer. What are the advantages? •



We can slightly over sharpen and then tone down the effect by reducing the opacity



•



If we need better sharpening we delete the sharpening layer and create a new one



•



By setting the blending mode of the sharpening layer to “Luminosity” we can prevent color shifts as the result of sharpening.



Here is how you work. You start with a most likely layered image:



Layer image 1. Create a new empty layer
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New empty layer 2. Merge the result of the layers below into this layer (Select “Merge Visible” in the layers palette menu, hold mouse button pressed, press Alt and release mouse)



New layer with merged result 3. Now use a sharpening method of your choice on this new layer. Slightly over sharpen does no harm as you can tone down the effect using opacity. 6.12.1 ADVANCED SHARPENING TRICKS 6.12.1.1 UPSIZE SHARPENING
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Some sharpening methods can work more effectively on upsized images. Be prepared that using this method will be slow as the upsized images are a lot bigger. More than 200% can be a great pain. We use the following steps for 200% upsizing: •



Duplicate image



•



Flatten image (in case it has layers)



•



Upsize (Photoshop bicubic or bicubic smooth) by 200%



upsizing by 200%



•



Use a strong sharpening technique of your choice



•



Downsize (Photoshop bicubic) by 50%
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downsizing by 50% •



Select all (Ctrl+A)



•



Copy the result



•



Close the duplicate file



•



Create a new layer on top of the original image



•



Paste the processed image into the new layer



6.12.1.2 DARK/BRIGHT HALO SHARPENING Many sharpening methods create strong halos. Most often the bright halos are more disturbing than the dark ones. The following technique can help you to deal with these artifacts. Here is what you do: •



Create a layer with a sharpened image (use any sharpening method you like)



•



Duplicate this layer



•



Set the blending mode of the lower layer to “Darken” and the opacity to about 75%.
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•



Set the blending mode of the upper layer to “Lighten” and the opacity to about 25%.



•



Then tune the opacity of both layers for your optimal result



We create these layers in actions and combine them in a single layer set. This way we can even control the opacity of the whole layer set to tune the sharpening down.



6.12.1.3 EDGE MASK SHARPENING Many times you only want to sharpen the edges of an image. Here is a simple was to create an edge layer mask. There are endless methods to create edge masks but this method will do in most cases. •



Create a new empty layer



•



Merge the result of the layers below into this layer (Select “Merge Visible” in the layers palette menu, hold mouse button pressed, press Alt and release mouse)



© 2002-4 Bettina and Uwe Steinmueller



284



•



Select the green channel



•



Perform Filter->Stylize->Find Edges
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Find Edges •



Use Levels to increase contrast on the edge image



All the areas that are black will be sharpened (as we will invert the mask later)
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•



Perform a Gaussian Blur at a radius of 3-7. This prevents harsh transitions from sharpened to not sharpened areas.



Blurred image •



Load Channel as Selection



Load the channel as selection •



Invert selection (Select->Invert)



•



Save Selection (Select->Save Selection..)



© 2002-4 Bettina and Uwe Steinmueller



287



Save Selection •



Select RGB in channels



•



Delete current Layer: We created this layer only to get a edge mask.



•



Deselect all (Ctrl-D)



All we wanted was to get a new alpha channel with the edge mask:



Edge Mask Alpha Channel Once you have the Edge Mask alpha channel you can apply this mask to nay layer like this: •



Create your sharpening layer



•



Select the sharpening layer



•



Load Edge Mask selection (Select->Load Selection)
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•



Add Layer Mask with “Reveal Selection”



•



Now you have added an edge selection layer mask to your sharpening layer.



Sharpening layer with edge mask
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6.12.1.4 THE “DOP SHARPENING FRAME” ACTIONS To provide you with a head start on creating your own sharpening actions we created the “DOP Sharpening Frame Actions”



DOP Sharpening Frame Actions The set is designed that you can include you special sharpening techniques and still use our framework. Here is what you can do. There are two actions that you can customize: •



help_sharpening_100percent



•



help_sharpening_200percent



You record you favorite sharpening process in both actions and make them selected and deselect our sample USM steps. The 100 percent action is used when we perform no upsizing during sharpening while the 200 percent action will be called for our upsizing sharpening (you can use stronger sharpening here). Here is what the different actions do:
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100_percent_edgemask Creates an edge mask (the Levels dialog will show up) and uses the 100% sharpening.



100_percent_no_edgemask_dark_bright No edge mask is used. It creates a layer set with dark/light halos and uses 100% sharpening.



200_percent_no_edgemask_dark_bright No edge mask is used. Uses 200% upsizing and the 200% sharpening action step.
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Clarifier This is an extra action that uses a low amount ultra high radius sharpening to improve local contrast
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6.13 ADDING SOME DIGITAL “SUN” As you know light is always a great factor in good photography. Too much sun creates too harsh contrast and deep shadows. We prefer overcast but it comes with the opposite problem flat shadows and very cold colors. This does not get solved by using proper white balance. What we need is better contrast and some warmer colors. Here is a one way to add a little digital “sun”.



Overcast scene 1. Add a Photo Filter adjustment layer to warm the colors slightly
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Use Warming Filter )´(85) at opacity 25% or lower 2. Create a curves adjustment layer to brighten the image



Brighten up image 3. Add more contrast with an S-Curve adjustment layer
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Add contrast using a S-curve Now the image looks like this:



A bit sunnier now This image is still lacking some contrast punch. To improve it even more we use a technique that Katrin Eismann shared with us. 4. Add a curves adjustment layer and set blending mode to “overlay”
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Way too much punch now The result is now way over the top. What do you do if we have the right effect but too much of it? Right, you turn down the opacity. This time 30% will be just right.



Final result Because you have only used adjustment layers to create this result you can tweak all the layers to tune the image up to your taste. © 2002-4 Bettina and Uwe Steinmueller



296



6.14 BRUSHING OFF YOUR NOISE Quite often only part of an image need noise removal. With the help of layer masks this easily can be done.



Image with lots of noise in the deep shadows



Crop with noise
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The following method will work with any tool that allows you to remove noise. 1. Create a copy of the image and remove the noise (we used an external tool called Noise Ninja).



Reduced noise 2. Load the image with the reduced noise into Photoshop 3. Select all (Ctrl-A) 4. Copy (Ctrl-C) 5. Create in the original image a new empty layer 6. Copy (Ctrl-V) Now you have the reduced noise image on top of the original image. But you want only the noise reductions for part of your image 7. Create a layer mask (



) for the layer with the noise reduced image



8. Fill layer mask with black (use the pain bucket) Now only the original image with all the noise is visible. Remember, a black layer mask blocks all change to be visible. © 2002-4 Bettina and Uwe Steinmueller
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9. Use the eraser tool with some soft brush at about 50% and remove the noise by painting into the dark and noisy areas of the image. Because the eraser tool reveals white in the layer mask the noise reduced version becomes visible. Here is how the layer mask looks like after performing this procedure:



Layer Mask after using the eraser tool



Layers and layer mask
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6.15 REDUCE CHROMATIC ABERRATION (CA) Chromatic aberration is actually a fault that nearly all lenses show. Whether is also shows in the final image is up to the quality of the lenses used. Most of the time CA shows as purple/green fringing and it gets stronger the more you get into the corners. Especially consumer class digital cameras show more CA then high end digital cameras with top lenses. Here is a real example we got from a Sony F828. We show how to make very useful images from such files. First get a version of panorama tools (you have to search the web where to find it, we have no right to distribute this free software so please do not ask where you can get the software). The following is working on the original file (that was not sharpened)



Original with strong CA Step 0: Because we are using layers we create a new layer with the result of all current flattened layers in it. Step 1: Using Panorama tools to remove some CA
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Correct radial shift in Panorama Tools These parameters may vary with the focal length.



After Panorama Tools This step removes some purple and even more the green CA fringing. Step 2: Reduce purple Use Photoshop Hue/Saturation tool to reduce the purple:
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Selectively reduce a narrow color range of purple



Will leave desaturated areas in the picture but not as bad as purple.



Result
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Step 3 (Optional): Reducing Magenta
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7 USEFUL PHOTOSHOP TOOLS



Camera: Hasselblad H1 + Kodak ProBack 645H © 2002-4 Bettina and Uwe Steinmueller
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This chapter is more or less a directory to quality third party tools. Most tools can be downloaded for trial Best is to try before you buy. A good resource is the “Photoshop Filter Directory” at Digital Outback Photo.



7.1 ICORRECT EDITLAB: CONTROLLING COLOR CAST



ICorrect Editlab iCorrect Editlab is our tool of choice if we want to click on neutral for white balance correction and we use a JPEG workflow.



7.2 OVERVIEW ON THIRD PARTY SHARPENING TOOLS It is hard to keep track of all the sharpening tools at the market. Here are just a few. Because we have reviews online we will not repeat it here. 7.2.1 NIK SHARPENER
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Nik Sharpener has a good reputation and was one of the first tools that brought resolution, printer type and viewing distance into the equation of sharpening. Our review 7.2.2 FRED MIRANDA’S SHARPENING PLUG-INS Fred sells very good and inexpensive sharpening plug-ins that do a good job. 7.2.3 FOCALBLADE Nice yet complex sharpening plug-in. Our review 7.2.4 PHOTOKIT SHARPENER Photokit SHARPENER is not just a sharpening tool but even more a very useful sharpening workflow: •



Capture Sharpening to remove the blur that results from the the digital capture process (e.g. the antialias filter)



•



Creative Sharpening to perform a selective sharpening of the image



•



Printer Sharpening to optimize the sharpening for a certain type of print process



Our review
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7.3 COLOR MECHANIC: SELECTIVE COLOR CORRECTION



Color Mechanic before/after view Color Mechanic Pro is an amazing tool for selective color corrections. Our review



7.4 REMOVE THE NOISE AND KEEP THE DETAIL 7.4.1 NEAT IMAGE Neat Image only on PCs and is one of the best noise removal tools around. Our review. 7.4.2 NOISE NINJA Noise Ninja currently also only works on PCs. Noise Ninja is easy to use and a bit faster than Neat Image. © 2002-4 Bettina and Uwe Steinmueller
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Our review. 7.4.3 FRED MIRANDA’S NOISE REMOVAL PLUG-INS Again Fred provides nice inexpensive solutions for noise removal. Our review.



7.5 FRED MIRANDA’S PHOTOSHOP TOOLS Fred Miranda’s Photoshop tools have a good reputation and cover many areas of image improvements.



7.6 PIXEL GENIUS Pixel Genius sells a couple of tools. Pixel Genius Photokit SHARPENER was already mentioned above. Also a very useful collection of tools is Photokit. Our review



7.7 NIK MULTIMEDIA We mentioned already Nik Sharpener. Also a very useful collection of filter is the Color Efex. Our review



7.8 POWERRETOUCHE PowerRetouche is an other very useful filter collection. Our review Of special interest for all B&W friends is their B&W sStudio Our Review
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8 PRINTING & PUBLISHING



Camera: Nikon D1X
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Important to understand is that the quality of the print is influenced by the following factors: ƒ



Print engine (this is obvious)



ƒ



Driver (e.g. we use the ImagePrint RIP from ColorByte and get excellent results)



ƒ



Inks



ƒ



Papers (Papers can make huge difference for inkjet printers)



ƒ



Printer profiles (a good profile is key not only for colors, also for shadow detail)



The two dominating high quality-printing techniques today are Lightjet printing and archival inkjet prints with Epson printers.



8.1 LIGHTJET PRINTING We only have experience with Calypso Imaging (one of the leading US Lightjet labs) so we will describe the process to prepare a file for printing at Calypso. ƒ



Download the printer profiles from Calypso Imaging (PC/Mac, Matte or glossy – we use the matte paper)



ƒ



Define the size of your print and keep it at 200DPI (this might involve some resizing down or up).



ƒ



Enlarge the canvas size in Photoshop to a Calypso standard size



ƒ



Select the full image and use “Select>Modify>Border” to create a 4 wide pixel border selection.



ƒ



Fill the border with black using the Pain Bucket and remove selection
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ƒ



Now convert the photo to the Calypso target profile (Image>Mode>Convert to Profile”).



ƒ



Save as uncompressed (!) TIFF



ƒ



Send it to Calypso via FTP or on a CD



8.2 INKJET PRINTING ƒ



Today’s inkjet printers allow you to use fine art watercolor papers (our favorite), excellent matte papers, canvas but also luster and glossy papers.



ƒ



We set our printer to 1440 DPI for all our prints. With the new Epson printers, you might even use 2880 DPI. Do not get this confused with the DPI you use for your photo in Photoshop. Comment by Phil Lindsay: “I suggest that the improvements (if detectable) in 2880 dpi be carefully weighted against the increase in ink consumption and slower printing times. Most of the Epson Reps at the show seemed to think 1440 was good enough.”



ƒ



We set our photos normally to 240 DPI in Photoshop for printing on our Epson 7600 but go as low as 180DPI before we use some upsizing technique (see below.



ƒ



We use the ImagePrint RIP (software Raster Imaging Processor) from ColorByte that is fast and has excellent dithering. Whether you use a RIP or the standard drivers, a good printer profile is the key to your success. If you want to create profiles yourself you need expensive hard and software. With all cheaper solutions, you get what you pay for.



ƒ



We recommend using our profiling service at Digital Outback Photo.



Making good prints requires a lot of experience and you should take your time to learn. Without good color management, it will take you so much longer. 8.2.1 NOTE ON METAMERISM
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Even with the current Ultrachrome generation of Epson printers (9600, 7600, 2200) there is still some metamerism visible. What is metamerism? •



A print that look neutral under tungsten light may look greenish under sun light or



•



A print that look neutral under sunlight might have a magenta cast under tungsten light



We don’t find it to be a big deal anymore with color photos we get from the Ultrachrome printers. For B&W prints we find it still disturbing and use here the ImagePrint RIP (see below)
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8.3 SETUP FOR EPSON PRINTERS AND USE WITH PHOTOSHOP 8.3.1 SETUP THE EPSON DRIVERS



Main Setup •



Select the right paper



•



Select the right inkset (here Photo Black)



•



Use custom mode (see next dialog)



© 2002-4 Bettina and Uwe Steinmueller



313



Advanced Settings •



Select right DPI



•



All other options as shown



•



Important: if you use proper profiles then select “No Color Adjustment”
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Paper settings The paper settings are pretty obvious.



8.3.2 PRINTING IN PHOTOSHOP Use Print Preview in Photoshop:



PS Elements Print Preview dialog •



Select “Show More Options”



•



Select Color Management



•



Profile: Select the right profile for your printer and paper



•



Intent: Can be “Perceptual” or “Relative Colorimetric”. This can vary on an image by image basis. Rule of thumb: For vivid images use “Perceptual” and otherwise “Relative Colorimetric” is a good start.
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8.4 UPSIZING There are some useful methods to upsize photos. Photoshop Bicubic Smoother Photoshop CS has now an improved method for upsizing. We cannot tell right now how it compares to other methods. But if you use ARC 2.0 then upsizing in ARC 2.0 is the way to go. Fred Miranda’s SI Actions Fred’s SI use the Photoshop bicubic method but does it in multiple smaller steps and the results just look better. Genuine Fractals This is the classic yet expensive upsizing tool. We used it quite often. The results can look more natural but less sharp than SI. Note: We were asked about our favorite method. Upsizing is very complex and controversial. We use bicubic for smaller upsizing and for the rest SI or Genuine Fractals. Please read Phil’s comment below. Comment by Phil Lindsay: “The issue of resizing is still pretty controversial. Fred's actions, Photoshop bicubic and Genuine Fractals all have their place.”
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8.5 OTHER PRINTING APPLICATIONS In some cases it might not be the best way to print only from Photoshop: •



Photoshop is bound to the printer manufacturer’s driver



•



Print multiple images on one sheet of paper



•



Special B&W printing



•



Client server printing



One class of these applications is caller RIPs (Raster Image Processors). RIPs are mainly used by professional printing shops to improve color management, place multiple images and get more throughput. 8.5.1 IMAGEPRINT RIP (MAC AND PC)
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ImagePrint RIP ImagePrint by ColorByte is a powerful yet easy to use RIP. What are the advantages of using ImagePrint? •



comes with free profiles for many papers



•



allow metamerism free B&W prints from standard color Ultrachome inks



•



allows toning of B&W prints (cold/warm blacks)



•



allows to control black point (since IP 5.6)



•



uses advanced dithering as it does not rely on the printer manufacturer’s drivers



•



Excellent client/server setup possible (frees you client machine)



8.5.2 QIMAGE (PC ONLY)
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Qimage



Qimage is a very inexpensive yet powerful printing solution for the PC: •



Fully color managed



•



Qimage is a batch processor



•



Page layout with multiple images



•



Automatic upsizing with high quality upsizing algorithms



•



Final print sharpening



•



Color equalizer sharpening for better image presence



•



Powerful user creatable print filters



•



Color fine tuning by changing selective colors



You might need some time to learn the user interface of Qimage but then it is an excellent printing application.
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8.6 PRESENT YOUR PHOTOS ON THE WEB Most photographers these days need or want to present their work on the Internet. There are many solutions out on the market from simple web generators to database driven applications. Note: The following screenshots are from Photoshop 7. The dialogs have changed a bit in Photoshop CS but are basically the same in functionality. Have a look at one of our sample portfolios at www.colors-by-nature.com.



Menu to call the "Web Photo Gallery" The feature is hidden in the "File->Automate->Web Photo Gallery" menu.
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Web Photo Gallery Dialog This is the main dialog and we will show most of the features step by step.



The top part let's you define the style (see below). The main fields are the source directory (here is your original portfolio in full resolution) and the destination directory (from here we upload to our web server) Photoshop comes with a couple of predefined styles. But this would be not too helpful if Photoshop would not allow to customize the layout. All you need to do is to change some HTML template files (you need to know a bit HTML though):
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New set of template files



You cannot change the names of these template files but change the content. Most of our changes were done in "SubPage.htm" and a few to "Thumbnail.htm". You can have look at our nor really sophisticated files from here (we renamed them from ".htm" to ".txt" so that your browser shows them as HTML source code). Note: Caption.htm is empty Once you have the right style, input and output directory you are a few clicks away from your first Web Photo gallery.



Global site information The "site name" can be used inside the templates to display the gallery name. We misused the entry for the "Photographer" to create unique © 2002-4 Bettina and Uwe Steinmueller
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counter names (no problem as on our site the photographers are always Bettina & Uwe Steinmueller).



Settings for the large slide window We opted for 700 pixel wide (JPG 8 compression) images as this is a compromise between big enough to enjoy and small enough to be protected against fraud. You can also use security features to protect your images but this might prevent the joy of viewing the images.



Settings for Thumbnails
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Here we use 100 pixels in the maximum dimension and left the rest unchanged.



Color Settings You also can set a color scheme. We stayed with one of the presets.



Security settings Finally you can also protect your images. We did not look into this in more detail. As said before this is a very simple web gallery tool but in some cases it does the job.
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9 CREATING B&W PHOTOS FROM COLOR IMAGES



Camera: Sigma SD10



© 2002 Bettina and Uwe Steinmueller



325



9.1 TURN COLOR IMAGES INTO B&W Converting color images has a lot potential.



B&W film Let’s first have a look at classic B&W films. Here is the scenario: •



Real world in color



•



Camera Filter (red, orange, yellow, green, ..)



•



B&W film spectral sensitivity



•



Developer



•



Negative



•



B&W print (paper grades, dodge & burn)



B&W with Digital Camera and Photoshop •



Real world in color



•



Digital color image (JPEG or from your raw converter)



•



Photo Filters in PS



•



B&W Channel Mixer in PS



•



All techniques about contrast, brightness, shadows and highlights



•



Doge & burn in Photoshop



•



Digital B&W print



We want to come as close as possible to the simulation of the classic B&W technique. We try to come close.
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9.2 B&W USING CHANNEL MIXER The Channel Mixer is a very powerful tool for B&W conversion. The channel mixer allows us to mix the red, green and blue channel into a grayscale image.



Channel Mixer Here is what Channel Mixer can do for you: •



Select the checkbox “Monochrome”



•



Define a percentage that each channel adds to the resulting grayscale image.



•



Should add up in most cases to 100%



Before you start using the Channel Mixer you should inspect the channels of the image and see whether you like one. Sometimes one channel shows exactly the B&W image you want.



© 2002-4 Bettina and Uwe Steinmueller



327



Sample



Color Image Inspect the channels:



Inspect the blue Channel
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blue



green



red If you like the green channel you can just use the Channel Mixer with 100% green like here:



Channel Mixer 100% green Here is the resulting image:
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B&W conversion



Note: Be aware that most often the blue and red channels show more noise than the green channel for digital cameras.
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9.3 ADVANCED B&W CONVERSION First you create a layer set (make it an action) with four adjustment layers:



Advanced B&W layer set You have the following four adjustment layers (from bottom to top): •



Photoshop Photo Filter



•



Channel Mixer



•



Curves with S-curve



•



Level



Now inspect the role of all these layers.
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Photoshop Photo Filter



Photo Filter and Color Picker You use the Photo Filter as a simulation of the classic B&W color filters. Select the checkbox “Preserve Luminosity” and you have a color filter that does not darken your image. Click on the color area (here orange) and the Color Picker will open up. Now comes the exciting moment. By changing the hue:



Hue slider You can change the filter color and check what this filter would do to your B&W image. The differences can be very dramatic. Once you found the filter setting you confirm both dialogs. © 2002-4 Bettina and Uwe Steinmueller
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Channel Mixer



Channel Mixer The Channel Mixer settings can simulate what would be else the spectral sensitivity of the B&W film. We often like the strong influence of the red channel and start off with the above settings.



Curves with S-Curve Contrast is critical for all images and even more so for B&W. This layer is a strong S-curve:
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Strong S-Curve The curve is actually too strong for most cases but this is intended as you control the actual strength via the opacity (25% is a good starting point).



Levels The levels let you control: •



Black point



•



White point



•



Brightness



•



output level compression black and white point
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Levels Dialog We set the output levels to:



Output Levels This way the deepest black and brightest white can be reproduced by the printer. Note: The lost shadows in the above histogram are not that much a concern as the minor lost highlights. This is a complex workflow but you can get great results and also tweak the adjustment layers quite easily at any time.
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9.4 B&W USING A PHOTOSHOP PLUG-IN There are Photoshop plug-ins that simulate the real B&W workflow even more. We use the PowerRetouche B&W studio.



B&W Studio in Film Mode This is a complex tool but so is the task at hand. What we like about B&W studio that is simulates the process that would happen using B&W film.
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Spectral Sensitivity



Simulate Spectral Sensitivity Different B&W films have different spectral sensitivities. B&W studio lets you select from some presets and then even let you control the seven sliders yourself. We use TriX most of the time. But in some cases we like to show e.g. blue darken then we change the values. All settings in B&W studio can be saved and loaded back.



Filters



Filter Simulation Then B&W studio lets you simulate different filters (like the ones you used with B&W film.
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Print



Print simulations The print settings really set B&W Studio apart from most other solutions. We just want to mention a few: Multigrade: You can control the "hardness" of the B&W photo (not quite the same as contrast). Contrast: Contrast on top of controlling "hardness" Exposure Stops: This is crucial as the conversion process might blow out highlights Highlight/Black Alerts: Set highlight alert to on and then eliminate blown highlights with the exposure slider.
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Zones Mode



The zones mode is a world by its own. We do not use this mode yet as we like the film mode.



Sample
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Elkhorn Slough



Converted with the shown settings



Conclusion Is this the perfect B&W control? Not quite yet as the preview is way too small for our taste (future versions will feature larger previews).
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9.5 COLORIZING YOUR IMAGES



A very interesting variation is a hybrid of B&W and color photo. Essentially it is a B&W photo with some very muted colors shining through.



Door in Soho, NY



Actually these are nice and punchy color. But this image also makes a very nice B&W photo.



B&W conversion © 2002-4 Bettina and Uwe Steinmueller
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This is a straight forward conversion using the “Advanced B&W Conversion” technique:



Layer set for B&W conversion Now look at the following version:



Colorized B&W All what needs to be done is tone down the opacity of the layer set to 80%:
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Toning down opacity Now what if you want to get rid of the red in the tiles? Just add a hue/saturation layer on top of the color image:



New Hue/Saturation layer What you actually do is to reduce the saturation of the reds by -100%:
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Reduce saturation of the reds Here is the final version:
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9.6 B&W WORKFLOW WITH ARC AND C1 Recently we started looking into B&W again. We always loved the power of abstraction that B&W provides. But we might not be alone in the observation that working in Color (have a look at our color work) and B&W is a very different thinking and more importantly feeling. In fact during the process of creating good B&W photos we get distracted by any color we see (especially of the same photo). What we want to do is thinking in B&W only. 9.6.1 COLOR CONVERSION TECHNIQUES We probably know most of the endless variations to convert Color to B&W and most of them are based on Photoshop: •



Channel Mixer (in full Photoshop only)



•



Hue/Saturation Desaturated



•



Photoshop plug-ins



•



Converting to gray in the raw converter (Adobe Camera Raw, Capture One DSLR)



Nothing can probably beat the power of all these techniques but they all require switching from color to B&W and distract the pure B&W viewing process. We have developed a pure B&W workflow with both ARC and C1. This means even the thumbnails and the previews are B&W.
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9.6.2 B&W WITH ARC 2.0



Creating B&W images with ARC 2.0 is pretty easy. Just set saturation to zero. You than can manipulate the tonality using: •



WB



•



Calibration data



Once you have the file converted and opened in CS. Change mode to “grayscale” and open the Shadow/Highlight tool.
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SH provides the ultimate control for tweaking your B&W tonality. For grayscale images the “Color Correction” slider turns into a “Brightness” slider. It is all there: •



Open shadows



•



Tone down highlights



•



Enhance midtone contrast



•



Optimize Brightness
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9.6.2.1 B&W THUMBNAILS AND PREVIEWS



You can then apply the saturation settings a all the pictures you want to use only in B&W and even the thumbnails and preview images show in B&W:



Full B&W view Important Note: Use the option “Sidecar xmp files” otherwise you other color images with the same name might turn gray too.
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9.6.3 B&W WITH CAPTURE ONE DSLR Using C1 (here C1 Rebel Edition)



First we realized that Capture One DSLR (C1) allows to view images in grayscale



. This is nice but not exciting.



C1 can also convert to grayscale on output.



This creates a grayscale image with a gamma of 2.2. We would like to have instead a B&W image in RGB mode. The solution is to create a new profile that converts to B&W. Can be done with the profile editor of Capture One DSLR Pro by desaturating the © 2002-4 Bettina and Uwe Steinmueller
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colors. Unfortunately C1 only allows a desaturation by 30% in one step. That is why we needed to repeat this process a couple of times to come up with a first B&W profile that we share with our readers. Now we are close to our goal of a 100% B&W workflow. 1. Select the new B&W profile as default for your camera



This has an amazing side effect: Also the thumbnails show in B&W 2. The Exposure, Contrast, Levels and Curves tools in C1 are very good to control the B&W contrast and brightness
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3. The techniques in Photoshop (Channel Mixer) allow you to filter the color image to get a better B&W rendering. Here we can (miss)use the WB control in C1.
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All three controls (Temperature, Tone Balance and especially Color Cast) have an influence on the B&W conversion (settings can also be saved). In addition the "Color Saturation" can be used to change the B&W rendering. You can even try to mess with the single RGB channels in Levels (Curves unfortunately don't allow this in C1 right now)



300D photo converted in C1 Rebel 9.6.3.1 WORKING IN COLOR & B&W If you want to work in B&W and color this use of C1 would only allow you to have one type of settings and previews in your cache. We installed C1 a second time in a different folder and ensure that the cache is not shared (by default). You don't even need to go through the licensing hassle again by copying the *.lic file from the old installation root to the new installation root. Printing with Epson 2200/7600/9600 Actually toning these B&W photos with Duo/Quatones or Gradient Map gets nice results. But in the end these print are not free of metamerism with the standard 2200/7600 inks. That is
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why we print using the ImagePrint 5.6 RIP and select some toning tint in the ImagePrint driver. It sounds like we are excited. Right, we are and hope you will give it a try. We are sure that other might come up with even better B&W profiles and they can share it with our readers through this site (e.g. Tri-X simulation profiles)



Sample



300D converted with C1 Rebel



We try to keep the B&W photo not too contrasty in C1. Later we open the file in Photoshop and apply some initial mild sharpening (applied as an layer so that we later could improve the sharpening). Then we tweak the black and if necessary the white point in an Adjustment Layer
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to get the final B&W snap. This way we can tweak the brightness and contrast later. Finally the image gets saved as PSD file. ImagePrint 5.6 can open these PSD files and print using a custom ImagePrint gray profile.
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CHAPTER



10



10 BACKUP AND ARCHIVE YOUR IMAGES



Camera: Nikon D1x Backup and archiving are both important and time consuming at the same time. Once you created a backup strategy you also need a solution how to © 2002-4 Bettina and Uwe Steinmueller
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find all your images. Most photographers work without any assistant and that makes it even harder to spend their valuable time on both issues.



10.1 BACKUP We are only talking about making backups of your images. 10.1.1 WHAT DO YOU NEED TO BACKUP? •



All raw files or original JPEGs (not touched by any photo editor)



•



All master TIFF/PSD files that are result of your editing work



In theory you can recreate the master files from your raw files but that is not only time consuming but also you get different results in many cases (not always better). Note: Have your main image data duplicated on two different physical media at any time. 10.1.2 BACKUP MEDIA What are the media available: •



Tape



•



CD/DVD



•



Harddisks



Tape All the professional backups in large data centers use tape backups. But these are most of the time expensive professional solutions. We did not do any investigations into backup via tape yet.



CD/DVD Today for large data volume only DVD is the read option. The main problem with CD/DVD is that we do not know how long these media last. © 2002-4 Bettina and Uwe Steinmueller
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There have been enough reports that CDs were not readable after even a year or so. What to do? •



Investigate into good brands of CD/DVDs



•



Make copies on two different brands of CD/DVDs



Harddisks A good strategy is also to make your backups on harddisks. We mirror all our critical image data on at least different physical harddisks (using Firewire drives from 120-250GB). We do the mirroring automatically via some a PC software. 10.1.3 BACKUP STORAGE It is also important where to store you backup media. Normally one copy should be at a different place than your main office as you may lose all your images due to a fire or other emergencies. 10.1.4 A NOTE ON RAW FILES On the long run you also make sure that you can still read all your raw files. This means that you still have the right raw converters available.
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10.2 ARCHIVING Once you have a big archive of image backups you need to find back your images. A good way to start is already the naming schema that we provided in the section “Camera to Computer” (Chapter 1). We like to use a tool that can be used as an adhoc image browser and can also be used on offline media. 10.2.1 THUMBSPLUS PRO (PC ONLY) Still the most easy to use tool for us is ThumbPlus Pro:



ThumbsPlus Pro (PC only) ThumbsPlus is not only an excellent adhoc image browser but can also be used to catalog offline media. Here are some (of the many more) features that make ThumbsPlus very powerful: •



can also use multiple databases
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•



Can search for file name in files and folders (if you name your folders right it saves a lot of work assigning manually keywords)



•



Assign keywords to files



•



Control the size of the thumbnails
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